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1. Introduction 

Welcome to the second article in the MAS (Malware Analysis Series). In the previous article 

(https://exploitreversing.files.wordpress.com/2021/12/mas_1_rev_1.pdf) we reviewed few relevant 

concepts about malware analysis such as unpacking and code injection, which are techniques used for 

evading and keeping the threat undetected by usual security defenses. Of course, there aren’t only these 

obstacles to circumvent during a reverse engineering session and, as you will learn during this series of 

articles, we usually have to bypass string encoding (not necessarily encryption), API resolving, anti-analysis 

techniques (debugging detection techniques, anti-disassembly techniques and virtual machine detection, 

for example) and different encryption/encoding tricks used by adversaries while analyzing malicious code. 

In this current part of MAS we are analyzing Qakbot (which is a simple family), but we don’t only be 

focusing on the point of view of threat hunting as it could be expected. This article aims to explain on string 

decryption, API resolving, C++ structures and C2 data extraction. These procedures can be seem strange for 

you at first time, but certainly you will get experienced with them as you’ve analyzed other samples. 

Nowadays is quite rare finding malware threats that aren’t packed, so that’s a good reason to list (last 

time) important breakpoints to set up while unpacking native code: 

▪ CreateProcessInternalW( ) 

▪ VirtualAlloc( ) | VirtualAllocEx( ) 

▪ VirtualProtect( ) | ZwProtectVirtualMemory( ) 

▪ WriteProcessMemory( ) | NtWriteProcessMemory( )  

▪ ResumeThread( ) | NtResumeThread( )  

▪ CryptDecrypt( ) | RtlDecompressBuffer( )  

▪ NtCreateSection( ) 

▪ NtMapViewOfSection( ) | ZwMapViewOfSection( ) 

▪ UnmapViewOfSection( ) | ZwUnmapViewOfSection( ) 

▪ NtWriteVirtualMemory( ) 

▪ NtReadVirtualMemory( ) 

As the reader will learn later, the same breakpoints might be useful even while unpacking .NET binaries 

(next articles) because high-level functions used by programs (native or managed ones) are translated into 

lower level functions still on userland and, afterwards, they invoke their counterparts on the kernel land. 

As certainly readers remember about, main functions used for allocating memory in native binary are: 

▪ VirtualAlloc( ) → VirtualAllocEx( ) → NtAllocateVirtualMemory( ) 

https://exploitreversing.files.wordpress.com/2021/12/mas_1_rev_1.pdf
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▪ HeapCreate( ) → RltCreateHeap( ) → NtAllocateVirtualMemory( ) 

▪ GlobalAlloc( ) → RtlAllocateHeap( ) → NtAllocateVirtualMemory( ) 

▪ LocalAlloc( ) → RtlAllocateHeap( ) → NtAllocateVirtualMemory( )  

▪ new( ) → HeapAlloc( ) → RtlAllocateHeap( ) → NtAllocateVirtualMemory( ) 

▪ malloc( ) → HeapAlloc( ) → RtlAllocateHeap( ) → NtAllocateVirtualMemory( )  

 

This sequence of calls can be also found in “The Art of Memory Forensics: Detecting Malware and Threats 

in Windows, Linux, and Mac Memory“ book (by Michael Hale Ligh, Andrew Case, Jamie Levy and Aaron 

Walters). So, it’s appropriate to review them: 

 

▪ VirtualAlloc( ): this function is able to reserve, commit and change state of a region of pages in the 

virtual address space and it also initializes this region to zero. Furthermore, it is usually used for 

allocation large regions of memory as, for example, to inject a PE file. It’s part of kernel32.dll.  

 

▪ VirtualAllocEx( ): its similar to VirtualAlloc( ), but it’s able to allocate memory in a remote process. 

It is part of kernel32.dll. 

 

▪ NtAllocateVirtualMemory( ): this function it’s similar to VirtualAllocEx( ) and it can be called from 

user-space or kernel-space. This API is part of ntoskrnl.exe.  

 

▪ HeapCreate( ): this function creates a private heap object. This API is part of kernel32.dll and it’s 

usually suitable for small allocations.  

 

▪ RtlCreateHeap( ): this function creates a private heap object that can used by the calling process. 

This API is found in ntdll.dll (user mode) and ntoskrnl.exe (kernel mode).   

 

▪ HeapAlloc( ): this function, which is found in kernel32.dll, allocates a block of memory from a heap. 

 

▪ GlobalAlloc( ): this function allocates a specified number of bytes from the heap. This API is part of 

the kernel32.dll. 

 

▪ LocalAlloc( ): this function, which is part of the kernel32.dll, allocates a specified number of bytes 

from the heap. Additionally, as Windows Memory Manager doesn’t provide a separate local heap 

and global heap, so this function and GlobalAlloc( ) have the same functionality. 

 

▪ RtlAllocateHeap( ): this routine allocates a block of memory from a heap. It’s part of the 

ntoskrnl.exe.  

 

▪ new( ): this operator allocates and initializes an object or array of objects, returning a pointer to the 

object. This API is part of the msvcrt.dll. 

 

▪ malloc( ): this function allocates memory blocks. It’s part of the msvcrt.dll 

Of course, there’re other memory APIs that could be used to allocate a memory region or even mapping a  

file into memory, but they are eventually you might now to be familiarized  with them: 
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▪ HeapReAlloc( ): this function is able to resize the allocated heap region, but it preserves the current 

data there. It’s part of the kernel32.dll. 

 

▪ VirtualAlloc2( ): this API allocates a region memory to the current or remote process. This function 

uses an interesting array of MEM_EXTENDED_PARAMETER structures and, as the VirtualAlloc( ), it’s 

part of the kernel32.dll.  

 

▪ CreateFileMapping( ): this function creates or opens a file mapping object, and it’s part of the 

kernel32.dll.  

 

▪ CreateFileMapping2( ): this function, which was introduced on Windows 10, creates or opens a file 

mapping object for a specified file, and it’s part of the kernel32.dll  

 

▪ MapViewOfFile( ): this function takes a handle from CreateFileMapping( ) and maps the file (totally 

or partially) into the process address space. It’s part of kernel32.dll.  

 

▪ MapViewOfFileEx( ): this function maps a file into the address space of a calling process and 

provides the option to specify the base memory address. It’s found in the kernel32.dll.  

 

▪ MapViewOfFile2( ): this function, introduced on Windows 10,  maps a view of a file into the 

address space of the specified process. This function is present in mincore.lib, but it’s also exported 

by kernelbase.dll.  

 

▪ MapViewOfFIle3( ): this function, introduced on Windows 10, maps a file into the address space of 

the specified process and one of its parameters also uses an array of MEM_EXTENDED_PARAMETER 

structures. This function is exported from kernelbase.dll.  

 

As you can check out, there isn’t an infinite array of possibilities for allocating memory and, eventually, 

even managed code ends passing any memory allocation through one of these APIs above, which makes 

learning about these functions a fundamental knowledge to unpack native and managed Windows binary 

as you’ll learn in this series of articles.   

 

2. Lab Setup 

During this article we’ll using the following initial environment: 

 

▪ Windows 7 (x86) and Windows 8.1 (x64) or Windows 10 (x64): If you need a Windows 10 virtual 

machine, Microsoft continue offering one with expiration time on this website: 

https://developer.microsoft.com/en-us/windows/downloads/virtual-machines/   

 

▪ REMnux: it’s a Ubuntu-derived distribution used for reversing engineering:  

https://docs.remnux.org/install-distro/get-virtual-appliance  

 

▪ x64dbg: it’s a modern debugger composed by x32dbg and x64dbg: https://x64dbg.com/#start 

https://developer.microsoft.com/en-us/windows/downloads/virtual-machines/
https://docs.remnux.org/install-distro/get-virtual-appliance
https://x64dbg.com/#start
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▪ IDA Home / IDA Pro (the best tool for reverse engineering, by far): https://hex-rays.com/ida-

pro/#main-differences-between-ida-editions  

 

▪ HxD is an excellent hex-editor that we could be used, for example, to check and fix PE headers 

manually. It can be downloaded from: https://mh-nexus.de/en/hxd/ 

 

▪ PEBear is used to visualize details of a PE Header and fix many binary issues. You can download it 

tool from: https://github.com/hasherezade/pe-bear-releases 

 

▪ Pestudio is mainly used to triage and collect different information of a potential malware. The tool 

(free and paid versions) is available here: https://www.winitor.com/features 

 

▪ Malwoverview: https://github.com/alexandreborges/malwoverview  

 

▪ Resource Hacker: http://www.angusj.com/resourcehacker/  

If you want to setup a good environment for analysis, you can use Flare VM 

(https://github.com/mandiant/flare-vm), which provides you with several good reversing engineering 

tools. To set up your virtual machine with FlareVM: 

a. Install or download a virtual machine running Windows 10: 

 

a. https://developer.microsoft.com/en-us/microsoft-edge/tools/vms/ 

b. https://developer.microsoft.com/en-us/windows/downloads/virtual-machines/  

 

b. Make sure that .NET 4.5 and PowerShell 5.1 are installed: 

 

a. (.NET 4.5) https://www.microsoft.com/en-us/download/details.aspx?id=30653 

b. (PowerShell) https://www.microsoft.com/en-us/download/details.aspx?id=54616  

 

c. Make sure your VM has 60 GB free file system and 2 GB RAM.  

d. Disable Windows Defender. 

 

e. Clone the Flare VM repository: git clone https://github.com/mandiant/flare-vm.git 

 

a. Open PowerShell as Administrator. 

b. Unblock-File .\install.ps1 

c. Set-ExecutionPolicy Unrestricted 

d. Set-ExecutionPolicy Unrestricted 

According to my experience, the installation script will reboot the virtual machine several times and the 

entire process takes a significant amount of time to be completed, so you should be patient.   

During reversing activities we’ll use other tools and few IDA plugins, which some of them demand further 

details to complete the installation, and we’ll explain about them later.  

 

https://hex-rays.com/ida-pro/#main-differences-between-ida-editions
https://hex-rays.com/ida-pro/#main-differences-between-ida-editions
https://mh-nexus.de/en/hxd/
https://github.com/hasherezade/pe-bear-releases
https://www.winitor.com/features
https://github.com/alexandreborges/malwoverview
http://www.angusj.com/resourcehacker/
https://github.com/mandiant/flare-vm
https://developer.microsoft.com/en-us/microsoft-edge/tools/vms/
https://developer.microsoft.com/en-us/windows/downloads/virtual-machines/
https://www.microsoft.com/en-us/download/details.aspx?id=30653
https://www.microsoft.com/en-us/download/details.aspx?id=54616
https://github.com/mandiant/flare-vm.git
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3. Gathering information 

The SHA256 hash of the sample is 

73e4969db4253f9aeb2cbc7462376fb7e26cc4bb5bd23b82e2af0eaaf5ae66a8.  

This binary can be downloaded from Malware Bazaar (https://bazaar.abuse.ch/browse/) directly from any 

browser or using Malwoverview:  

malwoverview.py -b 5 -B 73e4969db4253f9aeb2cbc7462376fb7e26cc4bb5bd23b82e2af0eaaf5ae66a8 -o 

0 

The first approach is to check this sample against Virus Total: 

 

 

[Figure 1] 

First impression about this output: 

https://bazaar.abuse.ch/browse/
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▪ Likely malware is packed.  

▪ The malware is really the Qakbot / Qbot.  

▪ The binary has an overlay (you can think that overlay is a kind of attachment to the binary and 

doesn’t make part of the its sections).  

▪ There are strange named sections.  

Using DiE (Detect It Easy: https://github.com/horsicq/Detect-It-Easy), you learn this sample was compiled 

with Borland Delphi.  

 

[Figure 2] 

Therefore, it would be a reasonable bet to believe this sample was packed using Borland and it is not a 

native malware written in Delphi. You should pay attention that there’re real malware written in Delphi 

(mainly banker trojans), but hopefully it isn’t the case.  

Our next step is searching for further information on a public sandbox and my daily choice has been Triage 

(https://tria.ge/dashboard), which is also implemented on Malwoverview. The real reason for I usually try 

to collect IOCs and URL used by the malware (probably C2 communication) is to have enough information 

on hands that could be useful during unpacking phase, binary reversing and C2 data configuration 

extraction. Other interesting information got from Triage are evasion techniques, persistence techniques, 

dropped files, Registry entries, processes and all kind of static and dynamic information. For sure you can’t 

blindly believe in all information provided by sandbox reports, but Triage has been very accurate on its 

analysis.  

https://github.com/horsicq/Detect-It-Easy
https://tria.ge/dashboard
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To use Triage on Malwoverview you need to get the task IDs associated to the any previously analysis 

associated to this malware sample and afterwards getting static and dynamic information: 

 

[Figure 3] 
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[Figure 4] 

 

 

[Figure 5] 

Based on Figures 3, 4 and 5, we have learned: 

▪ The botnet ID is “obama150”. 

▪ The campaign ID is “1640256791”.  

▪ The binary drops an DLL in the file system in C:\Users\<user>\AppData\Local\Temp folder.  

▪ Tasks are scheduled, so it likely uses them as a persistence mechanism.  

▪ The sample probably injects some code into a chosen process because APIs such as 

EnumerateProcess, MapViewOfSection and WriteProcessMemory and, apparently, explorer.exe is 

the target process. 

▪ The malware has an extensive list of C2 IP addresses (I truncated the output from Figure 4 and the 

C2 list is bigger).  
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4. Unpacking 

To unpack this sample we are going to use x32dbg (from x64dbg suite) and HxD editor. About the excellent 

x64dbg/x32dbg (written by Duncan Ogilvie), if you want to recognize and support him, so make a donation 

to his x64dbg project (https://github.com/sponsors/mrexodia). There’re also other quite relevant projects 

that might be supported in the security industry, whose tools have helped a lot during investigations and 

mainly reverse engineering’s sessions. 

Before starting the x64dbg session, try to open the sample on PEBear: 

 

[Figure 6] 

As you can read from picture above: 

▪ the binary is a DLL. 

▪ it’s a 32-bit PE file.  

▪ there’re several non-default sections.  

▪ there’s an overlay. 

If you check Exports tab (not shown), you will learn this executable has only one exported function 

(DLLRegisterServer) and its original name seems to be stager_1.dll.  

Holding this information we know we need to configure the x64dbg to debug this DLL. If you remember 

from first article of this series, we can set up a DLL debugging session by: 

▪ Putting up rundll32.exe (from C:\Windows\SysWOW64) under the debugger’s session.  

▪ Going to File → Change Command Line 

▪ Changing the text box and passing the malware and its exported function (or its number) as 

argument. 

https://github.com/sponsors/mrexodia
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▪ The final argument in the text box should be something similar to: 

"C:\Windows\SysWOW64\rundll32.exe" C:\Users\Administrator\Desktop\mas_2\mas_2.bin,#1 

▪ Please, remember that “mas_2.bin” is the name chosen for the article and #1 is the ordinal number 

of the exported function. 

▪ Restart the debugger and play it (F9) once, and the debugger will hit the Entry Point’s breakpoint.   

▪ Note: if you had picked up rundll32.exe from C:\Windows\system32 and restarted the debugger, so 

it would have changed automatically to C:\Windows\SysWOW64\rundll32.exe anyway.  

 

From this point, the debugging session is configured correctly and we can set up (CTRL+G) few breakpoints 

as shown below: 

▪ VirtualAlloc 

▪ ZwUnmapViewOfSection 

▪ WriteProcessMemory 

▪ NtResumeThread  

There’re some notes about these breakpoints on x64dbg: 

▪ Go to Options → Preferences and make sure that both System Breakpoint and Entry Breakpoint 

are checked. 

 

▪ Set breakpoints on VirtualAlloc, WriteProcessMemory and ResumeThread APIs when the x64dbg 

reaches the entry-point (after the system breakpoint). 

 

▪ I chosen VirtualAlloc( ) because it’s usually used by malware threads to allocate and unpack 

binaries into the memory (mostly self-injections) and WriteProcessMemory because likely 

according to the Triage’s report this binary are performing code injection into another process. 

Although it isn’t important for malware analysis, you should remember that VirtualAlloc( ) is 

normally used for big allocations, which it’s very appropriate to host an unpacked malicious binary, 

for example.  

 

▪ Remember that VirtualAlloc breakpoint must be set up on the return point of the API (ret 10) and 

not on its entry point.  

 

▪ The breakpoint on ZwUnmapViewOfSection should be set up only after the debugger execution 

has hit WriteProcessMemory’s breakpoint. 

 

▪ Probably NtResumeThread’s breakpoint will be hit twice, so continue the execution after the first 

hit because there will be educational reasons to do it.  

 

▪ I’ve set up a breakpoint on NtResumeThread to keep the control of the infection and avoid losing 

the control of the malware execution.  

If you want, it’s recommended to install DbgChild plugin into x64dbg/x32dbg to handle new processes 

created by the malware. In this article we won’t use it (although new processes are launched by the 
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binary), but it will be useful in the future. DbgChild is available from: https://github.com/David-Reguera-

Garcia-Dreg/DbgChild   

The reason about I’m setting a breakpoint on ZwUnmapViewOfSection is because it’d interesting to dump 

a mapped version of the malware and review the entire process of fixing it manually and automatically. In 

addition, Triage’s report told us about a possible memory mapping using MapViewOfSection( ).   

As in the first article I received messages asking about “the exact point” of setting a breakpoint on 

VirtualAlloc( ) in the first article, so the figure below shows it marked in red and light gray: 

 

[Figure 7] 

Now it’s time to run (Play or F9) the malware under the debugger. The first three hits on VirtualAlloc 

breakpoints won’t be useful. Keeping running after the third one likely will rise an exception, but there 

isn’t any problem. Pass exception to debugger (SHIFT+9) and, after a while, the debugger will hit another 

VirtualAlloc’s breakpoint. Once this breakpoint is hit, right click EAX register and choose “Follow in Dump”.  

Proceed with execution and a new VirtualAlloc’s breakpoint is hit. Once again, right-click in EAX register  

and choose Follow in Dump → Dump 2 (to prevent the first dump of being overwritten). Continue the 

execution and likely you will the an PE file being written in Dump 2.  

Nonetheless, it is NOT our executable yet! Why? Because if you examine the Dump2’s content, you will 

find this PE binary has the following sections: .text, .data, .mrdata, .rsrc and .reloc. The third section is not 

a default section, so we could bet this debugging session will show something better later. Therefore, 

right-click on EAX register and choose Follow in Dump → Dump 3.  

Continue the execution (F9). The debugger should stopped on another VirtualAlloc’s breakpoint, but this 

time there isn’t anything really useful. Right-click on EAX register and choose Follow in Dump → Dump 4.  

Resume the execution (F9) and you will find a new PE executable in the Dump 4 tab.  However, examining 

the content of this new PE format file, you’ll discover its header is not clean enough, so it wouldn’t so 

https://github.com/David-Reguera-Garcia-Dreg/DbgChild
https://github.com/David-Reguera-Garcia-Dreg/DbgChild
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useful for us. Right click the EAX register and pick up Follow in Dump → Dump 5. At same way, continue 

the execution (F9) and debugger will hit the NtResumeThread’s breakpoint. However, a PE format 

executable will appear in Dump 5 area and, this time, it’s the correct one as shown below: 

 

[Figure 8] 

Extract this file from memory by right clicking the Dump 5 area and picking Follow in Memory Map. From 

there, right click on the gray-highlighted region and choose “Dump Memory To File”. Save it wherever 

you want, but keep the suggested name because it contains the base address of the region, which might 

be useful during the procedure of fixing up the Import Table.  

We could have stopped at this point, but let’s proceed our debugger session because I’d like to show few 

concepts that could help you in future articles. Return to CPU tab and debugger will be still stopped on 

NtResumeThread’s breakpoint as shown below:  

 

[Figure 9] 

Continue execution (F9) until the debugger hit the WriteProcessMemory’s breakpoint. Once it hit it, so 

setup a breakpoint on the ZwUnmapViewOfSection( ) and continue the debugger execution (F9). Resume 

the execution and debugger will hit the ZwUnmapViewOfSection’s breakpoint. 
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It’s interesting to check the second argument (third line) in the Stack area. Why? If you check 

ZwUnmapViewOfSection( )’s information on the MSDN (from Microsoft) you will learn that the second’s 

argument is the base address of the view being unmapped, so this region will contain our file of interest. 

Thus, right click on the second argument’s address (third line in the Stack area because the first one is 

the return address) and choose “Follow DWORD in Dump → Dump 1”. If everything go correctly, you’ll 

see a image similar to the following one:  

 

[Figure 10] 

Once again, repeat the same steps to save the content into a file: right click on the Dump 1 area and pick 

Follow in Memory Map. From there, right click on the gray-highlighted region and choose “Dump 

Memory To File”. Save it wherever you want, but keep the suggested name because it contains the base 

address of the region that could be useful as I mentioned previously.  

We already have two dumped files: one from the NtResumeThread’s breakpoint (resulting from 

VirtualAlloc’s breakpoint) and the second one from ZwUnmapViewOfSection’s breakpoint. These files are 

enough, but we can continuing the debugger’s execution to learn effects caused by the malware. Thus, 

return to CPU tab and  resume the execution (F9).  

Probably the debugger will hit the NtResumeThread’s breakpoint, but if you look for created processes in 

the Process Hacker (https://processhacker.sourceforge.io/) or Process Explorer from Sysinternals Suite 

(https://docs.microsoft.com/en-us/sysinternals/downloads/sysinternals-suite) you’ll find an new 

explorer.exe process (in suspended mode) being forked from rundll32.exe. Additionally, this explorer.exe 

is a 32-bit executable (C:\Windows\SysWOW64\explorer.exe).  

Continuing the execution of the malware under the debugger control, a new instance of the x64dbg should 

be started and attached to the new explorer.exe process if you’ve installed the DbgChild plugin into 

x32dbg. Furthermore, checking the Process Hacker or Process Explorer, you’ll find two new explorer.exe: 

the first one that was suspended and second one that forks a conhost.exe process. If you proceed with the 

debugger’s execution (SHIFT+F9 because it raised an exception), the first explorer.exe fill be terminated 

and only the second one will be kept.  

On Process Hacker double-click the 32-bit explorer.exe and go to Memory tab.  

https://processhacker.sourceforge.io/
https://docs.microsoft.com/en-us/sysinternals/downloads/sysinternals-suite
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From there, sort regions according to the Protection column, look for a RWX base address then you’ll see 

the following image:  

 

[Figure 11] 

It’s interesting to realize that it’s a mapped region and there isn’t any counterpart on the  file system. 

Double-click it and you’ll have the following screen: 

 

 [Figure 12] 
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We have the injected code by the malware into the new explorer.exe process! Save it too.   

In my environment, the three extracted files, which are the same payload, were: 

▪ rundll32_04800000_from VirtualProtect.bin 

▪ rundll32_04BC0000_from_UnmapViewOfSection.bin 

▪ explorer.exe_0xc10000-0x21000.bin 

The first file is an unmapped version of the Qakbot and two other files are mapped version of the 

Qakbot.  

How we can check this information? Try open first two of them in a hexadecimal editor and you’ll see that: 

▪ in the rundll32_04BC0000_from_UnmapViewOfSection.bin the .text section starts at address 

0x400, so it’s in unmapped format. It’d possible to run it from file system. 

 

▪ in the rundll32_04BC0000_from_UnmapViewOfSection.bin starts at address 0x1000, so it’s in 

mapped format. 

 

 

[Figure 13] 

 

[Figure 14] 

 

Now we can open them up on PEBear to check PE format details and, mainly, the imported functions: 
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[Figure 15] 

 

[Figure 16] 

As you’re able to see, the first file (unmapped format) is perfect and we can list all Imported Functions, but 

in the second one (mapped format) the Import Table is messed up because sections’ raw addresses are still 

reflecting addresses from the disk (unmapped format) rather than memory (mapped format).  
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You could fix them by executing the following steps: 

▪ Copy all Virtual Addresses over the Raw Addresses. 

▪ Calculate the difference between sections’ start addresses and use this result as Raw Size and 

Virtual Size.  

▪ Change image base address to reflect the memory’s base address. On PE Bear it can done in 

Optional Hdr tab → ImageBase.  In my case, the Image Base is 0x04BC0000 (this information 

comes is available in the name of the extracted file).  

The original sections’ headers and changed sections’ headers are shown below: 

 

[Figure 17] 

 

[Figure 18] 

In the PEBear, right click on the filename, choose “Save the executable as” and provide a name. Open it up 

in PEBear and check for Imports:  

  

[Figure 19] 
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If you prefer, it’s possible to fix this file using pe_unmapper tool that is available on 

https://github.com/hasherezade/libpeconv/tree/master/pe_unmapper. Execute it as shown below:  

▪ pe_unmapper /in rundll32_04BC0000_from_UnmapViewOfSection.bin /base 04bc000 /out 

rundll32_04BC0000_from_UnmapViewOfSection_fixed.bin 

The result is the same and imported table is fixed. The third file file, which was extracted using Process 

Hacker, is also mapped and the approach is the same.  

Once again: all three extracted files are the same payload (Qakbot), so we could use any of them. 

However, I usually to use the unmapped version when it’s available, so let’s save it out of the virtual 

machines, rollback the snapshot and start to analyze it. 

 

5. Reversing 

No doubts, reversing any malware might consume a significant amount of time and most of the time it 

present several challenges: 

▪ Strings are usually encrypted.  

▪ In several opportunities, strings are organized in string tables.  

▪ APIs are hashed using logical operations or even encrypting algorithms.  

▪ Call conventions might be wrong.  

▪ Well-known functions are inline in the code and, sometimes, implemented in a different way.  

▪ There’re many C++ structures and, sometimes, we don’t have how to guess the exact size of each 

field/member. Worse, there could be structures inside structures and different STLs.  

▪ Public keys are usually “hidden” in the configuration data. 

▪ C2 data configuration is encrypted. 

▪ The network communication follows a specific protocol and, of course, it’s obfuscated and/or 

encrypted.  

As consequences of all these difficulties, it’s necessary to have a step-by-step approach while reversing any 

malware and, in a summarized way, you should have clears goals while doing it. Mostly it’ll be useful 

perform a general markup over all assembly / pseudo code (produced by the decompiler) to make the 

reversed code easier to understand as well as the general purpose of each subroutine. Certainly, over this 

markup process, we’ll find several hashed functions, encrypted data and crypto-algorithms, which 

demands writing Python 3 scripts to extract and decrypt valuable information.   

Before starting the general code revision, when we are going to rename variables, functions and their 

respective types, it would be recommended to configure a Python environment for writing our scripts 

quicky and, no doubts, several IDA Pro plugins that will help us while reversing the malware.   

Personally, before releasing a standalone Python script, I use Jupyter Notebook to write draft Python 

scripts because I think the debugging process is better (I learned it while working on fuzzing scripts). In few 

words, you can setup your environment as shown below:  

1. pip install jupyterlab 

2. jupyter-lab 

https://github.com/hasherezade/libpeconv/tree/master/pe_unmapper
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3. Choose Python 3 Notebook (right side) 

4. Rename the document (left side) 

5. If you accept my suggestion, try to create a private GitHub and push all your scripts onto there. The 

advantage of following this simple procedure is having  your scripts everywhere and whenever you 

need it (and within any virtual machine) Additionally, you can make them public when you feel 

comfortable with them. 

6. At end, export your scripts to standalone versions to be used in your daily work. 

 

About IDA Pro plugins, there’re an extensive list of quite useful ones that might help you during reversing 

malware in your daily job and, of course, each professional has her/his preferences, but eventually the 

presented plugins are interesting.  

Personally, I’m using IDA Pro version 7.7 with decompiler and Python 3.x as default version. To check which 

Python version is configured with your IDA Pro, open it up and, in the IDA Python prompt, type: 

▪ import sys 

▪ sys.version 

If you need to change the configured Python for IDA Pro, you can do it using “idapyswitch.exe”, which is 

available on the IDA Pro installation folder (in my case: C:\Program Files\IDA Pro 7.7).  

a. Flare Capa Explorer 

 

The plugin is excellent to detect capabilities of executable files inside the IDA Pro. In special, I like it 

because it helps to detect and identify crypto-algorithms, persistence, evasion techniques and 

network communication. To install it, execute: 

▪ pip install wheel 
▪ pip install flare-capa 

 
o Note: at time I’m writing this article, the default PIP package is not supported for IDA 

7.7, so you should install it using the following command: pip install 
git+https://github.com/mandiant/capa 

 
▪ clone the capa: git clone http://github.com/mandiant/capa.git.  
▪ clone the capa-rules: git clone https://github.com/mandiant/capa-rules.git 

 
▪ copy the capa_explorer.py plugin to IDA plugin directory. In my case: 

 
o C:\github\capa\capa\ida\plugin> cp capa_explorer.py "C:\Program Files\IDA Pro 

7.7\plugins" 
 

▪ On IDA Pro, load the binary and, eventually, it’d be recommended to select Manual Load and 
Load Resources for getting better results. However, you wouldn’t need to load the overlay.  
 

▪ Go to Edit → Plugin → Flare capa explorer and select “Program Analysis” tab. From there, click 
on the “Analysis” button, which will prompt you to select the folder containing the capa-rules 
(in my case, C:\github\capa-rules).  

http://github.com/mandiant/capa.git
https://github.com/mandiant/capa-rules.git
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▪ Note: from time to time, don’t forget to update Capa and capa-rules using “git pull” command.  
  

b. ApplyCalleType and StructTyper plugins 

Both plugins are available from the excellent flare-ida project. To install them: 

▪ git clone https://github.com/mandiant/flare-ida 

 

▪ copy apply_callee_type_plugin.py and struct_typer_plugin.py to "C:\Program Files\IDA 

Pro 7.7\plugins" folder. 

 

▪ copy the python folder (for example: “C:\github\flare-ida\python”) to Python folder from 

IDA directory (for example: C:\Program Files\IDA Pro 7.7\python) 

 

▪ Notes: 

o remember to update flare-ida using “git pull”. 

o After updating it you should copy the named plugins to the mentioned directory. 

o There’re other two plugins in the directory: stackstrings_plugin.py and 

shellcode_hashes_search_plugin.py. The former works only with Python 2.7 (we 

should change the IDA’s python configuration to fill this request) and the second one 

is a good plugin, but we’ll use a recently released plugin from OALabs.   

 

c. Findcrypt-yara 

 

This a simple, but effective IDA Pro plugin to find crypto constant, mainly. Of course, Flare Capa 

Explorer is also able to detect crypto-algorithms, but it’s always recommended to have two 

methods to do the same task. To install it: 

 

▪ pip install yara-python 

▪ git clone https://github.com/polymorf/findcrypt-yara.git 

▪ copy both findcrypt3.py and findcrypt3.rule to IDA’s plugin folder (C:\Program Files\IDA Pro 

7.7\plugins) 

 

d. HashDB 

HashDB is an excellent plugin from OALabs that performs string hash lookup against a remote 

database on OALabs.  Actually, it’s a welcome evolution and extension from the idea offered by  

shellcode_hashes_search_plugin.py plugin (created by Mandiant), which I personally used in 

several opportunities, and it’s able to provide an amazing integration with IDA Pro and really handle 

and detect most hashed strings. Install it by executing the following steps: 

▪ git clone https://github.com/OALabs/hashdb-ida 
▪ copy hashdb.py to IDA’s plugin directory (C:\Program Files\IDA Pro 7.7\plugins) 

▪ Attention: as HashDB performs lookup on OALabs server, so you should remember to keep 

Internet access in your environment.  

https://github.com/mandiant/flare-ida
https://github.com/OALabs/hashdb-ida
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Over the Flare Capa Explorer usage is suggested to load the resource section to its better operation. 

Furthermore, another good point is that non-sense data and function names (pointing to this section) are 

also prevented.  

Few recommendations just after opening any malware on IDA Pro are:  

▪ Decompile the entire program to avoid any decompiler’s issue later: File → Produce File → Create C 

File (or CTRL+F5). 

▪ Go to View → Open Subviews → Type Libraries (or SHIFT-F11) and confirm whether mssdk_win7, 

ntapi_win7 and ntddk_win7 are included. If they aren’t, so do it by using INS key. It might be 

useful to add into Signatures (View → Open Subviews → Signatures or SHIFT-F5) the vc32rtf 

library. Remember that, though all of libraries comes from Windows 7 base foundation, to analyze 

kernel drivers might be better to use libraries related to Windows 10.  

▪ Run Flare Capa Explorer plugin (Analyze button) and take a short note about main indications. 

Note: when you run it at first time, you’ll need to point the capa-rules directory.  

▪ Check Findcrypt’s results to collect further information.  

The Flare Capa Explorer screenshot follows below: 

 

 

 [Figure 20] 

Notes about the Flare Capa Explorer’s output (the list from figure above was truncated) that, eventually, 

might be useful as reference during analysis follow below: 

▪ There’s an indication of Base64 encoding on sub_1000B522 subroutine. 

▪ There’s a file enumeration on sub_1000B064.  
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▪ The malware has two subroutines (sub_100124AE and sub_100124F3) using Mersenne Twister (a 

kind pseudorandom number generator – PRNG). 

▪ Subroutine sub_1000F681 seems to be handling with SHA1 hashing algorithm.  

▪ Subroutine sub_10012C9B is handling with Import Table reconstruction.   

▪ Subroutine sub_10012862 seems to handle with PE header.  

▪ There’re indication of HTTP manipulation on sub_100074B3 and sub_1000E815 subroutines. 

▪ Subroutine sub_10014FD0 might be using Adler32 checksum algorithm, which is used of zlib 

compression library and it’s faster than CRC-32 algorithm. 

▪ There’re many references to XOR operations and, likely, many of them are involved in some kind of 

string encoding.  

It’s quite relevant to highlight that all findings from Flare Capa Explorer must be confirmed because 

there’re can be false positives.  

Another IDA plugin that could be used to find crypto-constants is the Findcrypt plugin and, no doubts, it 

might be useful for supplementing information given by other plugins:  

 

[Figure 21] 

The output is very interesting because: 

▪ CRC32 is being used in several places. One of places seems being a CRC32 table.  

▪ SHA1, as provided by Capa Explorer, is also shown.  

▪ Base64 table is also listed.  

▪ RIPEMD (RIPE Message Digest), a family of cryptographic hash functions, was found in several 

addresses 

Our starting point will be the DllEntryPoint function and we’ll navigate in several subroutines and moving 

forward according to the execution flow. Of course, it isn’t feasible to comment about all subroutines 

(there’re over 500 of them) in this article and we are going to focus on few of them only.   

The general basic approach is renaming variables, functions and functions’ arguments, changing its 

respective types (‘Y’ hotkey) in all possible opportunities and creating structures to attend C++ 

manipulations.  

Thus, a recommended approach is putting Disassembly View and Pseudocode View side by side  and 

synchronize both in the IDA Pro because almost all our work will be done on the decompiler.  
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[Figure 22] 

To rename functions I usually follow a kind of informal naming rule by adding a prefix such as “mw” (from 

malware) or “ab” (from my own name), and try to reflect the main goal of the function. I also use the word 

“wrap” or “w” to point that a function contain a reference to another important function. Other 

suggestions the might be useful while reserving the code using IDA Pro: 

▪ Try to find the enumeration associated to a constant my using the ‘M’ hotkey. 

   

▪ If there’s any decimal value (mainly a hash) that you need to convert to hexadecimal, use ‘H’ 

hotkey. 

 

▪ You should always look for code and data cross-references using ‘X’ hotkey to list cross-references 

to the cursor and CTRL-X hotkey to list cross-references to the current address. Cross-references 

from the current address (CTRL-J) and, on decompiler, global cross-references (CTRL+ALT+X) to a 

specific structure field are also very useful. 

 

▪ In the pseudo code, from Decompiler, if a function doesn’t have any argument, so double-check it 

against the assembly code because, sometimes, if the malware isn’t using a default call 

convention, the decompiler might miss arguments.   

 

▪ As I’ve mentioned previously, if you find any unknown constant, so do the simple action and search 

it on Google.  

On line 28, the subroutine sub_10009773( ) is a first challenge and we need to analyze to get a better 

understanding of it:  
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[Figure 23] 

The first argument is a size, the second argument points to a blob of encoded data (possibly strings) and 

the third argument points to another blob of encoded data (possibly a key because its length). We don’t 

have information about v1 and v2 yet: 

 

[Figure 24] 

 

[Figure 25] 

We took a note of these address because they will be useful: 

▪ blob 1 (maybe strings): 0x1001D5A8 

▪ blob 2 (maybe a key): 0x1001E3F8 

So, moving inside subroutine sub_1000865C (next page – Figure 26), we find a very interesting instruction 

on line 25: 

▪ v10[v5 - a5] = *(_BYTE *)(v5 + a2) ^ *(_BYTE *)(v5 % 0x5A + a3); 

In this expression, a2 is the blob 1 (probably a string table) and a3 is blob 2 (probably an encrypting key). 

There’s the operation “v5 % 0x5A”, which is also useful for our analysis and, strangely, “a4” argument is 

not being used:  
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[Figure 26] 

After renaming (‘N’ hotkey) subroutines, arguments and variable, we have the following: 

 

[Figure 27] 
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To manage this scenario and other similar situations, we usually write a Python script to decode the  

encrypted data by mimicking the pseudo code. Honestly, I almost never use debuggers during reversing 

analysis and prefer doing everything statically, but it’s a personal choice. Another approach I’m used to 

taking into account is extracting the data bytes (for example, string_table_1 and string_table_1_key on 

the Figure 27) reading directly from the database instead of copy it into the Python script. There isn’t good 

or bad choice here and everything is a personal option. The script to decrypt the data blob follows below: 

 

 [Figure 28] 
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[Figure 29] 

I’ve added comments over the code for helping you to understand the script, but it’s suitable leaving few 

observations: 

▪ I’ve used Jupyter notes while writing a reversing Python script because it’s easier to debug the 

code, though I always export and adapt it (if it’s necessary) to a standalone Python script.  

 

You’re able to find the start 

address of the .data section by 

using “CTRL+S” on IDA Pro  :) 
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▪ I’ve kept support functions separated from the main function, so that’s the reason of the line 

number sequence has been reset.  

The result from script execution is extensive and, usually, I wouldn’t put it here (waste of pages), but 

maybe is important to the reader being able to check own results.  

 

[Figure 30] 
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[Figure 31] 
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[Figure 32] 

If you check the output, there’re several quite meaningful strings that provide a good indication of 

techniques and checking done by the binary. Additionally, and as occurs in any modern malware, strings 

are encrypted, so it is not longer possible easily to find and follow the malware’s code using clear strings.   
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Note the last line of the output: the script extracts correctly a string at byte 1486 of the string table, so this 

possibility will be useful later.  

A very simple function that is useful is sub_10008773 (mw_ww_string_length) → sub_100087CB 

(mw_w_string_length), which calculates a string length and its used frequently on the code (list cross-

references on sub_10008773/mw_ww_string_length using ‘X’ hotkey). Additionally, it’s a good 

opportunity to use an useful resource of IDA Pro that’s the user enumeration creation. As in this piece of 

code “-1” means “CHAR” and “-2” means “WCHAR”, so I created a enumeration (Figure 36) that contains 

only two fields and used ‘M’ hotkey to change the values. How did I discover about “char” and “wchar”? 

The subroutine being called on line 17 (sub_1000C52C/mw_str_length_char) accepts _BYTE as argument  

and subroutine sub_1000C545 (mw_str_length_wchar) on line 21 accepts _WORD as argument.  

 

 

 

 

  

 

 

 

 

 

 

               

 

 

  

 

 

 

       [Figure 34]                       [Figure 35] 

 

 

 

 

  

 [Figure 36] 

[Figure 33] 



https://exploitreversing.com 

 

32 | P a g e  
 

The subroutine sub_10012C0A (mw_ww_construct_imports) → sub_10012C0A (mw_ww_fill_imports) 

brings something new in this series of article that’s the PE format manipulation:  

 

[Figure 37] 

If you convert these numbers (60 and 128) to hexadecimal (‘H’ hotkey), you’ll find two important numbers: 

0x3C and 0x80. The 0x3C is an indication of e_lfanew field from IMAGE_DOS_HEADER structure and 0x80 

is an indication of Import Directory (_IMAGE_IMPORT_DESCRIPTOR structure)  within 

IMAGE_DATA_DIRECTORY structure.  Two excellent references about PE Format follow below: 

▪ PE 102 (by Corkami): https://github.com/corkami/pics/blob/master/binary/pe102/pe102.pdf 

▪ PE File Format Offsets (by Sunshine): http://www.sunshine2k.de/reversing/tuts/tut_pe.htm  

Sometimes it isn’t so simple to figure out what’s happening during a PE manipulation, so both these 

references above will be quite useful and, if you can, work with them together. Our first step is trying to 

improve this pseudo code and, as a requested step, we have to add few PE structures into IDA Pro and  

change some variables’ types to point to them. 

To add new standard structures, go to Structures tab (SHIFT-F9), press “INS” key, click on “Add standard 

structure” and type “_IMAGE_DOS_HEADER”. Once IDA found it, choose it and click on OK button.  Repeat 

the same steps to _IMAGE_IMPORT_DESCRIPTOR. 

Although only these two PE structures are used in this specific threat (for example, during the Remcos 

malware further structures are necessary) , there are other ones you might want to insert into IDA Pro 

when it’s needed. A shortened list of them follow: 

▪ _IMAGE_DOS_HEADER 

▪ _IMAGE_NT_HEADERS 

▪ _IMAGE_DATA_DIRECTORY 

▪ _IMAGE_EXPORT_DIRECTORY 

▪ _IMAGE_OPTIONAL_HEADER 

▪ _IMAGE_SECTION_HEADER 

▪ _IMAGE_IMPORT_DESCRIPTOR 

https://github.com/corkami/pics/blob/master/binary/pe102/pe102.pdf
http://www.sunshine2k.de/reversing/tuts/tut_pe.htm
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After adding the structures mentioned previously, let’s perform a sequence of tasks: 

a. check them at Structures tab to confirm their presence there then put the cursor on offset 60 (or 

0x3C), press “T” hotkey (Select a structure functionality) and choose _IMAGE_DOS_HEADER. Likely 

the IDA Decompiler has changed the representation of the offset to e_lfanew from 

_IMAGE_DOS_HEADER structure. Update the decompiler with F5. 

 

b. Using both documents about PE format that I left as reference, it seems that taking 0x3C as 

reference, the offset 0x80 (128) seems to indicate the structure _IMAGE_IMPORT_DESCRIPTOR 

(ImportDirectory), which belongs to _IMAGE_DATA_DIRECTORY structure.  

 

c. Therefore, click on “v3” and press ‘Y’ hotkey to change the type from “int v3” to 

“_IMAGE_IMPORT_DESCRIPTOR *v3” (please: note that is a pointer to the structure, so it includes 

a ‘*’ symbol). Update the decompiler with F5. 

 

d. Repeat the same step on variable dword_1001E664 by changing its type from “int” to 

“_IMAGE_IMPORT_DESCRIPTOR *”. Update the decompiler with F5. 

 

e. Finally, click on number “20” and press “T” hotkey (Select a structure) and pick up 

_IMAGE_IMPORT_DESCRIPTOR. Update the decompiler with F5. 

 

After having renamed some variables and a function (to be commented in next paragraphs), the IDA 

pseudo code looks a bit better: 

 

[Figure 38] 

Moving inside the subroutine named sub_1000881A (mw_w_construct_import_structures), I recommend 

you to rename all arguments according to argument’s names from Figure 38.  
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After accomplishing this task and renaming few variables, we have:  

 

[Figure 39] 

The mw_HeapAlloc API has the following code after having renamed function’s name, arguments and 

applied a standard enumeration by using ‘M’ hotkey (look for ‘HEAP’ and the exact constant name 

appears): 

  

                   [Figure 40] 

Proceeding with our analysis, go into subroutine sub_10008892 (mw_construct_import_structures) , 

rename variables and arguments (‘N’ hotkey), and you will have something similar to this: 

 

 [Figure 40] 

Now we can return to DllEntryPoint routine (press CTRL + E and choose DllEntryPoint), analyze the next 

subroutine that, no doubts, is the most important one so far because it is going to introduce a new concept 

in this series of articles that’s dynamic API resolving because, as you’ll see, APIs functions are represented 

by hashes.  
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Go into sub_1000E369 subroutine, which is called 13 times (‘X’ hotkey), and there you are going to find 

sub_10009773 subroutine (mw_w_decode_string_table), which we’ve already analyzed and, if you check 

its cross-references (‘X’ hotkey), you will discover that it’s called 23 times! Furthermore, you’re going to 

find an API being called, but it doesn’t have a well-formed name (dword_1001E684) and points to zeroed 

data at .data section. That’s a big indicator of dynamic API resolution! Your first view of this piece of code 

should be the following one: 

 

[Figure 41] 

Have you remember about the routine “string_decrypter_search” from our the Python script (Figure 28)? 

As a test, we’ve used “1486” as offset to look for the exact string on the string table and we found 

“kernel32.dll” (last line on Figure 32). Thus, we could insert a comment here to remember later.  

Go into sub_1000E31E and you’re see the subroutine sub_100087B5, which is our previously renamed 

wrapper to HeapAlloc( ).  You’ll be able to rename few local variables, but there is not much more than it.  

Once you enter into sub_1000E15A, few secrets start to be revealed because we’ll see several hints about 

what’s happening: 

▪ several well-known decimal number being used (60, 120, 124 and so on). 

▪ two calls subroutines: sub_1000C52C and sub_1000D5AA. 

▪ a very interesting and essential XOR operation happening.  

▪ another hexadecimal being used: 0x6C6C642E 

▪ Calls to LoadLibrary( ) and GetProcAddress( ) 

Before explaining anything, you are already able to guess what’s happening: API resolving! Yes, we finally 

reached our first API resolving case in our series and you’ll learn how every information is really important 

here.   

Therefore, lets me show both sub_1000E31E and sub_1000E15A (without any renaming and just like you’ll 

be seeing) before proceeding with our analysis: 
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[Figure 42] 

 

[Figure 43] 
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[Figure 44] 

As reversing tasks become more elaborated, it’s advisable to rule a better name convention, so it might 

use the suffix “arg” for every argument and “var” for all local variables. Sometimes I get out of using suffix 

“var” because it might make the code very polluted, but it depends on the situation and context. 

I believe that code associated to sub_100087B5 subroutine (on Figure 42) is really understandable and you 

don’t have any issues.  



https://exploitreversing.com 

 

38 | P a g e  
 

Within sub_100087B5 subroutine, there’s only a HeapAlloc( ) call, which you can change the second 

argument to a symbolic representation (‘M’ hotkey), which results in HEAP_ZERO_MEMORY. 

The sub_1000E15A is different and presents relevant details. Once again, you need to read those 

mentioned documents about PE format and, according to offsets, change the associated types. For 

example, the decimal “60” (0x3C – remember: to convert to hexadecimal, use ‘H’ hotkey) refers to 

e_lfanew field (from IMAGE_DOS_HEADERS) that points to _IMAGE_NT_HEADERS, so you can change the 

type of “v3”  (int) to  _IMAGE_NT_HEADERS*. A similar approach can be done with decimal “120” (0x78), 

which points to Export Directory, so you should change the v4’s type (int) to 

_IMAGE_EXPORT_DIRECTORY * (you must import this standard structure into your IDA before using it).  

Likely the aspect of your code will become a bit better.  

Another quite interesting aspect is the XOR operation with a fixed value (0x218FE95B) in one of the lines 

because the malware is calling the sub_1000D5AA subroutine and performing a XOR with its returned 

value.  As you’ll learn about it, this constant value (0x218FE95B) is essential for us.  

Near to end of the code (Figure 44), there’re two API calls: LoadLibrary( ) and GetProcAddress( ). To make 

code better and use standard argument types, it’s recommended to invoke a plugin named 

“ApplyCalleeType” that we mentioned previously.  

Thus go to Edit → Plugins → ApplyCalleeType → Use Standard Type and search for the given API name as 

shown below. Afterwards, update the IDA Decompiler’s view (F5). Repeat this procedure to each API calls 

over the code.  

 

[Figure 45] 

I’ve renamed all subroutines, arguments and variables, so the reversed code after working on instructions 

from Figure 43 and Figure 44 follows below: 
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[Figure 46] 

Going into the pending sub_ 1000C52C subroutine, we have the following reversed code: 

 

[Figure 47] 

I used this reference to CRC32 algorithm to interpret the code on Figure 47: 

https://en.wikipedia.org/wiki/Cyclic_redundancy_check. Furthermore, IDA marks CRC32 constants and 

Findcrypt plugin also reports CRC32 usage.  

Therefore, we know that this malware is probably using CRC32 as hashing function for resolving API 

names, but how can be find further evidence and manage this API resolution statically? Returns to 

subroutine sub_1000E369  (mw_w_function_api_resolving) and ask for cross-references (‘X’ hotkey): 

 

[Figure 48] 

https://en.wikipedia.org/wiki/Cyclic_redundancy_check
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All these subroutines are calling sub_1000E369, so there’s a good chance to discover further evidences 

within these subroutines. Analyzing the references above, there’re several calls coming from 

sub_1000606C, so it’s a good choice to go and examine the code: 

 

[Figure 49] 

If you check all unexplored bytes references (suffix unk_), there’re many encrypted bytes that, once you 

convert some of them to double word, you will have the following bytes: 

 

[Figure 50] 

According to our previous analysis, it is likely these double words are CRC32 hashes. Throughout of my 

career, I was used to writing scripts for decrypting any kind of encrypted bytes, but it was a time 

consuming work. Afterwards, I used the make_sc_hash_db.py script (from flare-ida project: 

https://github.com/mandiant/flare-ida/tree/master/shellcode_hashes) and it really helped me a lot. Since 

last year we have available the excellent HashDB IDA plugin authored by OALabs, which it’s a welcome 

evolution and significant improvement from make_sc_hash_db.py  idea, and it have been very useful. 

How can we use HashDB plugin to tackle our resolving API issue? The first step is to remember of a prior 

and critical information that’s the XOR key used in the CRC32 operation: 0x218FE95B.  

https://github.com/mandiant/flare-ida/tree/master/shellcode_hashes
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Therefore, our first step is going to Edit → Plugins → HashDB, setting that XOR key (personally, I think 

better right clicking on the XOR key and choose “HashDB set XOR key”) and click on Refresh Algorithms.  

 

[Figure 51] 

Now you must right click on the first hash (Figure 50) and choose “HashDB Hunt Algorithm”:  

 

[Figure 52] 

As expected, the CRC32 was detected. You must mark the CRC32 algorithm above and click OK. Now right 

click again on the first CRC32 hash and choose HashDB Lookup that you see the following message: 

 

[Figure 52] 
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That’s great! HashDB plugin, which communicates with OALabs server, discovered that the first hash 

stands for LoadLibraryA( ) from kernel32.dll, so probably all of the following hashes (up to a sequence of 

four zeroed bytes) are also CRC32 hashes from the same module.  In this case, it’s worth to press “Import” 

button to bring all of hashes into the IDA database. Please, be patient because it takes some time and, 

while it’s working, IDA Pro seems to hang.  

Now you must select all of the remaining bytes until the sequence of zeros, right click and choose 

HuntDB Scan IAT. This operation take some seconds to finish. Once the task is completed, you’ll see the 

following:  

 

[Figure 53] 

That’s excellent! If you search down from this address, you’ll figure out that there’re many sequence of 

bytes that represent API’s names from other functions, so you should hunt them and repeat the same step 

by marking all block of bytes until a sequence of zeroed bytes, right clicking and choosing HuntDB Scan IAT. 
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Although it might seem a bit tedious, this task is very worthwhile and produces an amazing result.  All of 

hashes (and its respective function’s names) are in .rdata section.  

It’s quite relevant to mention that all that HashDB plugin creates an enumeration named 

“hashdb_strings_<algorithm_name>” and you’re able to check it up going to View → OpenSubviews → 

Enumerations (SHIFT+F10). 

The figure follows only for illustrating few other blocks of hashes and their respective function names: 

 

[Figure 54] 

I won’t reproduce each “API block” here, but you’re going to find APIs from ntdll.dll, user32.dll, 

ntapi32.dll, advapi32.dll, shlwapi.dll, shell32.dll, userenv.dll and so on.  

After having run HashDB plugin to decrypt all API names, the next step is creating structures for holding 

the API block from each DLL. For example, all APIs represented in Figure 53 comes from kernel32.dll, so 

you should mark all of them, right-click and choose  “Create struct from selection” . Click on the name of 

the just created struct and use ‘N’ hotkey to give a name that reflects the structure’s purpose and DLL’s 

name where all these APIs are found (for example: mw_struct_iat_kernel32). Repeat the same steps for 
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other blocks of API’s names and, of course, if you don’t remember the DLL’s name from each block of API’s 

names come from, so search them on Google.  

After creating structures (one for each API names’ block) you can verify them on Structures tab (SHIFT-F9) 

as shown below: 

  

[Figure 55] 

The code presented on Figure 49 should have changed to the following one: 

 

[Figure 56] 

We don’t finished it yet and there are further procedures as shown below: 

▪ Rename (‘N’ hotkey) subroutine sub_1000E369 to something better (in my case, as I’ve mentioned 

previously, mw_w_function_api_resolving).  

 

▪ Rename (‘N’ hotkey) variables on left to reflect the structure’s content. For example, 

dword_1001E684 to ptr_struct_iat_kernel32. 

 

▪ Change the type of each renamed variable of left from ‘int’ to ‘mw_struct_iat_kernel32 *’. Pay 

attention: it’s a pointer, so there must be the ‘*’ at end.  

 

▪ Remember: if you committed any mistake, you can undo the operation (CTRL+Z) anytime. 

 

This name and type scheme are very recommended to make the pseudo code more readable and easier to 

understand what’s going on. After having finished these steps, the code on Figure 56 should be much 

better:  
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 [Figure 57] 

Having managed these issues we can continue our analysis. From this point onwards, we’ll use the same 

API hash resolving technique by concerning to hash’s resolving and structure types only.  

The mw_iat_construction subroutine is called from three places (‘X’ hotkey), so we can examine one of 

them (for example, sub_10005FBC subroutine): 

 

[Figure 58] 



https://exploitreversing.com 

 

47 | P a g e  
 

In the decompiler, before continue analyzing the code, update it by pressing F5. Go inside sub_1000D1C9, 

you’ll have a large piece of code and part of it follows below (I renamed only the three first lines): 

 

[Figure 59] 

We won’t analyze all this code right now, but only interesting parts. Furthermore, it’s suitable opportunity 

to show few well-known techniques when we have large allocation of heap and its respective usage (as an 

array) spread over several parts of the code. In this case, the malware allocates 6852 bytes and soon 

afterwards it does several attribution of values to slots of this array and, definitely, working with indexes 

(1557, 133, 134, 135, 137…) is not a good idea. Based on this information, we can create a structure of 

1713 DWORDs (it’s huge!) and assume that each one can hold a pointer (32-bit).  Of course, there’re many 

doubts about this statement: 

▪ How do we know whether the structure is only composed by dwords?  

▪ How do we know whether the structure is not composed by other structures too? 

Pay attention here:  initially, we’re going to generate a simple structure here containing 1713 double 

words (dd).  Usually creating a simple structure that contains double words is what we do and almost 

always works, but our decision is WRONG in this case and there’s a clear hint on Figure 58. Why am I 

doing it? To show how things really work in a real malware analysis. Later I’ll return to this point, but I 

want to be clear in saying that the technique which I’m going to show you is CORRECT, but in this case the 

interpretation is WRONG. Thus, we have two ways to create a simple structure composed by dwords: 

▪ Use the own IDA Pro features to accomplish the task automatically.  

▪ Create your own structure as a C code then import it into IDA Pro’s database.  
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Using IDA Pro features directly is easier (no doubts), so we can create a structure in Structures tab 

(SHIFT+F9) with given name of name “struct_allocated_memory_1” (I’ll change it for something better 

later) and also create a first field (field_0) being dword (dd). If you don’t know how to create a structure, 

don’t freak out because it’s quite simple. Press “INS” to create the structure, provide a name (in my case 

was struct_allocated_memory_1) , press OK. The exact window is shown below: 

 

[Figure 60] 

Click on the “end” of the structure (00001AC4 struct_allocated_memory_1 ends) and press “D”  to create 

a new field (field_0). Click on this first and unique field_0 and press “D” twice until its type has changed to 

double word (dd). Finally, press ‘*’ and the following window will come up:  

 

[Figure 61] 

Please, pay attention to details: 
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▪ The array size is 6852/4. 

▪ The checkbox “Create as array” is unchecked.  

Finally, click on any ptr_allocated_memory_1_ref variable and press “Y” hotkey. Change its type to the 

same type of the structure you just created previously (Figure 60). For example, in my case: 

▪ (before the change): _DWORD* ptr_allocated_memory_1_ref 

▪ (after the change):    struct_allocated_memory_1* ptr_allocated_memory_1_ref 

Press F5 to update the Decompiler view. 

We can do other interesting improvement. On line 54 from Figure 59 you can see the following code: 

▪ if ( !((int (__stdcall *)(_DWORD, _DWORD, int *, int *, char *, int *, char *))ptr_struct_iat_advapi32-

>ptr_LookupAccountSidW)(… 

Click on the the respective structure’s member (ptr_LookupAccountSidW), which is a well-known 

Windows API. Go to Edit → Plugins → StructTyper:  

 

[Figure 62] 

Find the structure (mw_struct_iat_advapi32), mark “Prefix RegEx” and fill it up with any suffix (usually I 

use initial of my name, but here I’m using ‘ptr_’) and press OK.  

Only a note: remember that StructTyper plugin is recommended to apply argument’s type to well-known 

structures, so it’s perfect for our case. Anyway, you do NOT need to use this plugin because, even without 

using it, our pseudo code is OK.  

Press F5 to update the compiler and, as you’ll see, the final code will be much better: 
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[Figure 63] 

Therefore, two general recommendations are: 

▪ If there’s an API call, so try the ApplyCalleeType plugin on the API to improve arguments 

representation to well-defined types and names according (or similar) to MSDN. 

 

▪ If there’s a call (usually seen when handling API hashing) where the API’s name is a member of a 

structure, so try to use StructTyper plugin on the structure’s member and choose the structure 

containing the API member.  

Continuing our analysis, there’re other places in the code that also use encrypted strings, so our script to 

decrypt strings would be useful again. For example, going to sub_10004C5A → sub_10002D5C → 

sub_1000109A, which calls the mw_string_decryptor subroutine using different arguments: 

 

[Figure 64] 
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As shown above, the encrypted strings is at address 0x1001D0B0 and the decryption key is at address 

0x1001D050, so calling our script is enough to decrypt them: 

 

[Figure 65] 

As we’ve already decrypted two string tables using the same script, so it’d better to improve it to make our 

lives easier. Therefore, let’s use IDA Python to make comments at each call for 

mw_w_decode_string_table subroutine with the exact string given by the offset address in table string. 

Does it sound complicated? Certainly it’s much easier you might imagine as you will learn below: 
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[Figure 66] 
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[Figure 67] 
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Few changes happened to this new version of the script: 

▪ As it’s using IDA Python libraries, so run it from: File → Script Command  (SHIFT+F2) 

 

▪ The script import idaapi and idautils libraries on lines 1 and 2. Further information about them: 

 

▪ https://www.hex-rays.com/products/ida/support/idapython_docs/ida_idaapi.html#ida_idaapi 

▪ https://hex-rays.com/products/ida/support/idapython_docs/idautils.html  

 

▪ Lines 57 to 64 was inserted to handle input values and find the start address of the .data section 

automatically. 

 

▪ Line 99 was commented out because we aren’t longer interested in listing all decrypted strings. 

 

▪ Line 104 returns the a formatted and indexed string similar to “string[1486]: kernel32.dll” (for 

example). 

 

▪ A new routine named comment_string_offset has been introduced.  

 

About the new routine, some comments follow below: 

▪ On the line 108, the get_name_ea_simple function gets the linear address of the function. 

Reference: https://hex-rays.com/products/ida/support/idadoc/255.shtml  

 

▪ On the line 110, this script is interacting with each cross-reference, via CodeRefsTo function, to the 

given function. In other words, we aren’t interested in learning the address of the function, but 

each line of code calling it. Referece: https://hex-

rays.com/products/ida/support/idapython_docs/idautils.html#idautils.CodeRefsTo  

 

▪ On the line 111, the idc.prev_head function gets the address of the previous instruction right 

before the calling instruction for string table’s decryptor subroutine. Reference: https://hex-

rays.com/products/ida/support/idadoc/265.shtml  

 

▪ On the line 112, given the address of the previous instruction, the idc.print_insn_mnem function 

gets its mnemonics. Reference: https://hex-rays.com/products/ida/support/idadoc/274.shtml   

 

▪ On the line 113, the script is only interested in mov instructions. Explanation: I confirmed that most 

(but not all as we’re going to learn soon) strings offsets for the string table were associated with a 

particular instruction: mov ecx, <offset>. Thus,  the script focuses on mov instructions.  

 

▪ On the line 114, the idc.get_operand_type function filters instructions that the second part of the 

mnemonic is an immediate value. Reference: https://hex-

rays.com/products/ida/support/idadoc/276.shtml  

 

https://www.hex-rays.com/products/ida/support/idapython_docs/ida_idaapi.html#ida_idaapi
https://hex-rays.com/products/ida/support/idapython_docs/idautils.html
https://hex-rays.com/products/ida/support/idadoc/255.shtml
https://hex-rays.com/products/ida/support/idapython_docs/idautils.html#idautils.CodeRefsTo
https://hex-rays.com/products/ida/support/idapython_docs/idautils.html#idautils.CodeRefsTo
https://hex-rays.com/products/ida/support/idadoc/265.shtml
https://hex-rays.com/products/ida/support/idadoc/265.shtml
https://hex-rays.com/products/ida/support/idadoc/274.shtml
https://hex-rays.com/products/ida/support/idadoc/276.shtml
https://hex-rays.com/products/ida/support/idadoc/276.shtml
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▪ On the line 115,  the int(idc.print_operand(p, 1)[:-1], 16) nested functions gets the text 

representation of the operand (an immediate value) associated to instruction and convert it to 

decimal, which will be used as offset in the string table. Reference: https://hex-

rays.com/products/ida/support/idadoc/275.shtml  

 

▪ On the line 116, it calls string_decrypter function.  

 

▪ On the line 117, a filtering is done to only isolate the decrypted string and nothing more.  

 

▪ On the line 118, the idc.set_cmt function sets the comment at the same line of the string table 

decrypter function’s call. No doubts, we could have set the comment at same line of the immediate 

value, but I thought it’d better to follow the first approach. Reference: https://hex-

rays.com/products/ida/support/idadoc/204.shtml 

 

▪ Lines 119 to 127 contain the second part of the algorithm. I’ve verified that, sometimes, the string 

offset loading (mov eax, <string offset>) wouldn’t happen at the instruction right before the string 

table decrypter subroutine call, but two instructions before. In few word, the script tests whether 

the instruction before the string decrypter function call has the format “mov <reg>, <immediate 

value”. If it doesn’t, so it goes up one level and test the second previous.  

 

▪ On lines 129 and 130 the same routine (string_decrypter) is called twice, but with arguments 

different, from distinguished string tables, and string offsets also different. In this case, only the 

string associated to that offset is going to be shown on the output.   

 

▪ Lines 133 and 134 performs comment markup on the code. Please, pay attention to the fact that 

we need to provide the name of the wrapper subroutine used to call the string table decrypter 

subroutine.   

 

How can we confirm it worked? We can check the code or check cross-references associated with the wrap 

of the string table decryptor routine: 

 

 

[Figure 68] 

As you’re can confirm, decrypted strings from the strings’ table was added as a comment. To confirm them 

using cross-references it quite simple: 

https://hex-rays.com/products/ida/support/idadoc/275.shtml
https://hex-rays.com/products/ida/support/idadoc/275.shtml
https://hex-rays.com/products/ida/support/idadoc/204.shtml
https://hex-rays.com/products/ida/support/idadoc/204.shtml
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[Figure 69] 

Unfortunately, not all strings table decrypter function had an instruction with an immediate value working 

as string table offset close to them. Of course, the script can be improved a lot.  

I could have followed the same approach to mark up comments on the decompiler’s side, but I think it 

wouldn’t bring a major value to our analysis. Just in case you want to do, the base script is the following 

one:  

def make_decompiler_comments(addr, comment): 
    c_function = idaapi.decompile(addr) 
    treeloc_struct = idaapi.treeloc_t() 
    treeloc_struct.ea = addr 
    treeloc_struct.itp = idaapi.ITP_SEMI 
    if c_function: 
        c_function.set_user_cmt(treeloc_struct, comment) 
        c_function.save_user_cmts() 
 

Few words and references that might help you: 

▪ Decompile(ea, hf=None, flags=0) and decompile_func(*args) functions. Reference: 

https://www.hex-

rays.com/products/ida/support/idapython_docs/ida_hexrays.html#ida_hexrays.decompile 

 

▪ c_function is a reference to a decompiled function (the result) represented as a cfunc_t structure, 

which makes part of a c_tree representation. References: 

https://www.hex-rays.com/products/ida/support/idapython_docs/ida_hexrays.html#ida_hexrays.decompile
https://www.hex-rays.com/products/ida/support/idapython_docs/ida_hexrays.html#ida_hexrays.decompile
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▪ https://hex-rays.com/products/decompiler/manual/sdk/structcfunc__t.shtml 

▪ https://hex-rays.com/products/decompiler/manual/sdk/hexrays_8hpp_source.shtml  

 

 

[Figure 70] 

▪ Ctree location structure is used to denote comments. References: 

 

▪ https://hex-rays.com/products/decompiler/manual/sdk/structtreeloc__t.shtml  

▪ https://hex-

rays.com/products/decompiler/manual/sdk/hexrays_8hpp_source.shtml#l05902  

 

 

[Figure 71] 

▪ ITP_SEMI value is a member of item_preciser_t enumeration that is used to assign comments to 

ctree items. References:  

 

▪ https://www.hex-rays.com/products/decompiler/manual/sdk/hexrays_8hpp_source.shtml 

▪ https://www.hex-

rays.com/products/decompiler/manual/sdk/hexrays_8hpp.shtml#a219c95f85c085e6f539b8

d3b96074aee  

▪ https://www.hex-

rays.com/products/decompiler/manual/sdk/hexrays_8hpp.shtml#a219c95f85c085e6f539b8

d3b96074aee  

 

https://hex-rays.com/products/decompiler/manual/sdk/structcfunc__t.shtml
https://hex-rays.com/products/decompiler/manual/sdk/hexrays_8hpp_source.shtml
https://hex-rays.com/products/decompiler/manual/sdk/structtreeloc__t.shtml
https://hex-rays.com/products/decompiler/manual/sdk/hexrays_8hpp_source.shtml#l05902
https://hex-rays.com/products/decompiler/manual/sdk/hexrays_8hpp_source.shtml#l05902
https://www.hex-rays.com/products/decompiler/manual/sdk/hexrays_8hpp_source.shtml
https://www.hex-rays.com/products/decompiler/manual/sdk/hexrays_8hpp.shtml#a219c95f85c085e6f539b8d3b96074aee
https://www.hex-rays.com/products/decompiler/manual/sdk/hexrays_8hpp.shtml#a219c95f85c085e6f539b8d3b96074aee
https://www.hex-rays.com/products/decompiler/manual/sdk/hexrays_8hpp.shtml#a219c95f85c085e6f539b8d3b96074aee
https://www.hex-rays.com/products/decompiler/manual/sdk/hexrays_8hpp.shtml#a219c95f85c085e6f539b8d3b96074aee
https://www.hex-rays.com/products/decompiler/manual/sdk/hexrays_8hpp.shtml#a219c95f85c085e6f539b8d3b96074aee
https://www.hex-rays.com/products/decompiler/manual/sdk/hexrays_8hpp.shtml#a219c95f85c085e6f539b8d3b96074aee
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▪ The set_user_cmt function set the comment on the function determined by the C tree location 

structure. Reference: https://hex-

rays.com/products/decompiler/manual/sdk/structcfunc__t.shtml#ac69c7a795de52c7858c88084da

e91fa6  

 

▪ The save_user_cmts function saves comments into the database. Reference: https://hex-

rays.com/products/decompiler/manual/sdk/structcfunc__t.shtml#a5750da6d0b4a3dfc9e606ecbe5

65ee65  

 

Returning to the entry point (CTRL+E) and going down to the code, you can confirm that sub_1000978D 

subroutine is calling sub_100086E2, which is essentially the same decrypter that we saw previously. 

However, when I tried using the same IDA Python script from Figures 66 and 67, many cross-references 

calling the wrapper function weren’t commented and soon I found the reason: most of string offsets 

were being passed as argument by using a ‘push’ instruction and not a ‘mov’ instruction. Therefore, I 

adapted the function  comment_string_offset function (Figure 67 – line 106) to check the existence of 

both mnemonics as shown below: 

 

 
 

[Figure 72] 

As you can confirm, changes were small and the only observation is that on lines 121 and 137 we’re 

interested in getting the first operand because ‘push’ instruction has only one operand. After these 

changes,  we’ve got much better results as shown on the next page: 

https://hex-rays.com/products/decompiler/manual/sdk/structcfunc__t.shtml#ac69c7a795de52c7858c88084dae91fa6
https://hex-rays.com/products/decompiler/manual/sdk/structcfunc__t.shtml#ac69c7a795de52c7858c88084dae91fa6
https://hex-rays.com/products/decompiler/manual/sdk/structcfunc__t.shtml#ac69c7a795de52c7858c88084dae91fa6
https://hex-rays.com/products/decompiler/manual/sdk/structcfunc__t.shtml#a5750da6d0b4a3dfc9e606ecbe565ee65
https://hex-rays.com/products/decompiler/manual/sdk/structcfunc__t.shtml#a5750da6d0b4a3dfc9e606ecbe565ee65
https://hex-rays.com/products/decompiler/manual/sdk/structcfunc__t.shtml#a5750da6d0b4a3dfc9e606ecbe565ee65
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[Figure 73] 

We’re able to notice that, at same way, it isn’t possible to get all calls commented because some of them 

either are resolved dynamically or the string offset is found many instructions before the calling the 

function and trying to catch them might cause side effects without any real gain for our task. 

 

There’re few additional tips that I’d like to provide with readers before continuing the reversing session: 
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▪ If you’re renaming any Windows API’s parameters, my suggestion is to try to use the same 

parameter’s name that you find on MSDN. At first time, it might sounds like a huge and time 

consuming task, but you’ll learn that it’s worth and save significant time while trying to figure out 

what’s going on.  

 

▪ During your reversing session, you should consider to save your work in regular times by using the 

CTRL+W hotkey to avoid losing your mark up. 

 

▪ As you’ve noticed, we have to constantly googling for APIs definitions, parameters and lots of 

constants, and everything is done using a browser. Nonetheless, according to my experience, you 

might consider to use the MSDN offline version and, as I like programming so much, my suggestion 

of environment is: 

 

o Visual Studio: https://visualstudio.microsoft.com/  

 

o Windows SDK: you can get it installed with Visual Studio or apart from it: 

https://developer.microsoft.com/en-us/windows/downloads/windows-sdk/ 

 

o Install the MSDN offline: To get it installed, install the Help Viewer from Visual Studio 

installer by going to Individual Components tab and marking Help Viewer.  Afterwards, 

open the Visual Studio and go to Help → Add and Remove Help Content. Mark 

“Programming reference for Windows API” under Windows, remove everything else you 

don’t want (depends your experience), click on Update and wait some minutes. 

 

 

[Figure 74] 

https://visualstudio.microsoft.com/
https://developer.microsoft.com/en-us/windows/downloads/windows-sdk/
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Proceeding with our analysis, we returned once more to the entry point (CTRL+E) and pay attention to the 

call to CreateThread( ) on line 45: 

 

[Figure 75] 

The CreateThread function has, as you should already know, the third parameter as a pointer to the 

function to be executed which is mw_threat_function. Going inside of it, the function is the same from 

Figure 58, but that created structure was renamed from struct _allocated_memory_1 to struct 

struct_sysinfo and renamed ptr_allocated_memory_1 to ptr_struct_sysinfo, as shown below :  

 

[Figure 76] 

It’s likely you’ve noticed few points of interest in this Figure 76 such as: 
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▪ on line 3, the code tells us that ptr_struct_sysinfo  (formerly ptr_allocated_memory_1) is a pointer 

to a _OSVERSIONINFOA structure.  

 

▪ On line 6, this pointer receives the return of function mw_get_sysinfo (sub_1000D1C9). If we 

examine this function, on its line 33 is called the wrapper to HeapAlloc and it allocates 6852 bytes. 

The return of this operation, which is a pointer,  is saved into a local variable (here named 

ptr_struct_sysinfo). At end of the function this pointer is returned, so it should be a pointer related 

to _OSVERSIONINFOA or a similar structure. 

 

▪ on line 11, we have something not usual so far that’s the notation mw_VirtualProtect(*(_DWORD 

*)&ptr_struct_sysinfo_ref[3].szCSDVersion[84]);. The index 3 suggests there are many structures 

(this particular one is the number 4) and, because the field’s name, it seems to be of type 

_OSVERSIONINFOA or containing same size. A similar effect occurs on line 12. 

 

▪ If you get references (‘X’ hotkey) to ptr_struct_sysinfo_ref, you’ll find there’re 158 cross-

references.  

Therefore, we can concludes that ptr_struct_sysinfo is actually pointing to a structure of structures and, 

likely, all these structures might be _OSVERSIONINFOA or similar size. As you already know, 

_OSVERSIONINFOA is a structure defined in winnt.h that contains operating system version information 

such as major and minor version number, build number , platform ID, of the operating system and 

service pack (szCSDVersion). Its composition is shown below: 

 

 [Figure 77] 

The information above was extracted from MSDN, and you can get it from Internet 

(https://docs.microsoft.com/en-us/windows/win32/api/winnt/ns-winnt-osversioninfoa) or locally, as I’ve 

already explained, so another hint about accessing the local (offline) version of the MSDN follows: if you 

want to call Help Viewer out of Visual Studio environment, so you should create a shortcut setting as 

target the following command: "C:\Program Files (x86)\Microsoft Help Viewer\v2.3\HlpViewer.exe" 

/catalogName VisualStudio15 /launchingApp Microsoft,VisualStudio,15. Of course, this command line 

depends on your Help Viewer version and Visual Studio version.  

The structure above has 148 bytes and, based on considerations above, it confirms what I had already 

mentioned previously (page 47) that the struct_sysinfo should be nested structure (structure composed by 

structures) and not a simple one.  

https://docs.microsoft.com/en-us/windows/win32/api/winnt/ns-winnt-osversioninfoa
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As the _OSVERSIONINFOA structure has 148 bytes and mw_get_sysinfo subroutine (originally named 

sub_1000D1C9) has a call “mw_HeapAlloc (6852)” (check Figure 59, page 47, line 33), so we need to do a 

simple math: 6852 / 148 =  46. Thus, struct_sysinfo is composed by 46 generic and similar structures.  

Here’s decision point and it’s relevant to underscore one aspect: we’re trying to understand pieces of the 

malware and improve the IDA pseudo code based on our analysis, but there isn’t a “right or wrong” here 

and, eventually, that’s an interesting experience to comment about because some people believe we 

should be always exact and, sometimes, it isn’t possible because there’re necessary context to improve the 

interpretation. For example, if I believe that a field has a goal and, after some analysis and learned 

contexts, I realize that field’s name or even its type wasn’t correct, so I return, fix it and move forward. It’s 

ways hard reversing code and try to make it more “readable”.  

On this case, we might take three different approaches: 

a. Creating generic structure of structures and renaming fields along the analysis are usually the best 

bet because provides flexibility with us. Personally, I always try to follow this approach whether the 

situation and context allow to do.   

 

b. We might use the own _OSVERSIONINFOA structure and its default names. A strange fact is that 

szCSDVersion field should hold a string related to applied service packs, but it seems being used  

and sliced for any other goal, and the final meaning it’s a bit weird and hard to follow, so I don’t like 

it, though the code is already using  _OSVERSIONINFOA structure. 

 

c. A third possibility would keeping the a huge structure of DWORDs (6852 / 4 = 1713) and work with 

them without facing any problem.  

I don’t believe the malware’s author is using a structure of _OSVERSIONINFOA structures, but a similar 

structure with the same size. Anyway, this won’t do a big difference on our static analysis (believe me). I 

could use the approach C, but I’ll choose the approach A because there seem be structure of structures in 

our code. Additionally, I’m guessing assuming that each member structure has the same size of 

_OSVERSIONINFOA structure and, of course, there isn’t any certainty about it and my assumption is based 

on Figure 76 because, on the top of the code,  there’s a reference to _OSVERSIONINFOA structure. 

Therefore, as the _OSVERSIONINFOA has 148 bytes then our generic structure will also have 148 bytes 

and, based on this information, we know it’ll have 148 / 4 = 37 dword fields.  

According to explaining so far, we have to create two structures:  

▪ SYS_INFO: composed by 37 dword fields. 

▪ SYS_INFO_ALL: composed by 46 SYS_INFO structures. 

To manage this context, we need to do few steps to get a good pseudo code. First, remove the 

struct_sysinfo on page 48 because, as we’ve learned, it isn’t a simple structure composed only by dwords 

fields.  

To accomplish the task: 

▪ Go to View → Open Subviews → Structures (SHIFT+F9) 

▪ Find the struct_sysinfo, right click on it and choose “Delete structure type…” and confirm the 

operation.  
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Next task is creating a new structure (named SYS_INFO), which is composed by 37 dwords. This time, we 

are going to use the second approach mentioned on the top of page 48. Thus, to create this structure of 

structures, execute the following steps: 

▪ go to View → Open Subviews → Local Types (SHIFT+F1) 

▪ press INSERT key from your keyboard.  

▪ Now fill it up with the following content and take care with the syntax.  

▪ Hint: write a two-line python script to generate all fields automatically. 

 

 
[Figure 78] 
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Basically, we need to repeat steps from page 64, but this time creating a new structure (SYS_INFO_ALL) 

composed by 46 SYS_INFO structures. Once again, use Python for help you: 

▪ go to View → Open Subviews → Local Types (SHIFT+F1) 

▪ press INSERT key from your keyboard.  

▪ Now fill it up with the following content and take care with the syntax.  

 

[Figure 79] 
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Once the new type was created, so you should import both into Structures tab. Right click on the 

SYS_INFO local type and pick up “Synchronize to idb”. Confirm the import. Now SYS_INFO local type has 

been imported as a structure into the Structure window. Do the same with SYS_INFO_ALL. 

On the next step, you should apply the new structure as a type for few variables and, as we’ve done similar 

steps previously, so no news here.  Based on Figure 76, double click on mw_get_sysinfo (sub_1000D1C9) 

and, as you already examined previously (page 48, picture 63) there’s a call to wrapper of HeapAlloc on 

line 33 as shown below: 

▪ ptr_struct_sysinfo = (#198 *)mw_HeapAlloc(6852u); 

Click on ptr_struct_sysinfo variable, press ‘Y’ hotkey and change its signature from “int 

*ptr_struct_sysinfo” to “SYS_INFO_ALL *ptr_struct_sysinfo”. It there was a signature such as “#<number 

*ptr_struct_sysinfo, it’s due the fact of you have deleted the previous simple structure. There isn’t any 

problem and make the change normally. Repeat the same procedure for ptr_struct_sysinfo_ref variable 

(line 34). Finally, press F5 and check how our code is better and, this time, correct:  

 

[Figure 80] 

The reader can wonder reasons for I having took the wrong way on page 47 (it wasn’t a simple structure, 

but a structure of structures) and afterwards I have fixed it. Simple: I wanted showing you how real 

analysis actually happen. Yes, I already knew the structure was a bit more complex (I said it on page 47), 

but taking a wrong interpretation I could explain a new technique to create automatically a new structure 
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(and we’ll use this technique several times in this article or next ones) and to explain that, as a reverse 

engineering, you can easily re-interpret an information, fix it and everything OK.  

Let’s move forward to next pieces of code. The code on Figure 80 is a good start point and on line 39 you 

see the function mersenne_twister_initialization, which is also pointed by the Capa Explorer as being 

Mersenne related. 

Mersenne Twister is a well-known PRNG (Pseudo Random Number Generator) , but it presents some 

changes when compared to a default one.  

In a classical PRNG, a seed is provided to initialize a generator into an initial state (state 0). This initial state 

(state 0) is used as input of a one-way function X to generate the first random number (random 0). To 

generate a second random number, the previous state (state 0) is transformed into a new state (state 1) 

by using a second function Y, which is used as input of the one-way function X to generate a new random 

number (random 1). If you want a third random number, the previous state (state 1) is transformed into a 

new state (state 2) by using the the same function Y. This new state (state 2) is used as input of the same 

function X to generate a new random number (random 2). And process keep going on. 

The Mersenne Twister has a working slightly different from the default PRNG. One of first changes is that 

the initial state (state 0) is not used as input of a first random number (random 0 at the prior paragraph).  

The Mersenne procedure starts providing a seed, which is used as input by an initialization function and 

the initial state (state 0) is generated. A Twist function is applied on this initial state (state 0) and the state 

1 is generated. To generate the first random number, a function Y is applied on the state 1. Is the 

procedure equal to a default PRNG? Almost. The function Y, which is used to generate the random 

number, is reversible (not a one-way function) and this function is able to generate 624 random numbers 

with the same state as input. When all random numbers was generated using the state 0 as input, so a 

new state can be created. Appling the Twister function on the state 0, the state 1 is created. The function 

Y is applied on the state 1 and new random numbers (up to 624) can be created. The process keep going 

on.  

In malware analysis we’ll see Mersenne Twister algorithm being used in many malware samples. This 

generated random number may be used in different scenarios as string generation, C2 communication, 

and so on. The general algorithm is composed by few parts as initialization, random number generator and 

the twist function that is responsible for transforming the previous state into the next one.  

The mersenne_twister_initialization function called on line 39 / Figure 80  is shown below: 

 
[Figure 81] 
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Constants helps us to detect and identify this code on Figure 81 as being related to Mersenne Twister. 

Returning to code shown on Figure 80 (that was truncated because the routine is longer), there’re tons of 

APIs being called directly or through a wrapper function such as GetCurrentProcess( ), 

GetTokenInformation( ), AllocateAndInitializeSid( ), NetGetJoinInformation( ), NetGetDCName( ), 

LookupAccountSidW( ),  GetVolumeInformationW( ), GetSystemEnvironment( ), GetComputerName( ),  

and so on. The remaining part of subroutine shown in Figure 80 follows below: 
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[Figure 82] 

Obviously, there isn’t enough and space to analyze each line and function here, but let’s look inside 

mw_mersenne_string on line 73: 

 

[Figure 83] 

On line 10, the previously explained mersenne_twister_initialization subroutine is called. So after this 

point, we have the mw_mersenne_random subroutine being called on line 13 and, the random number 

returned by this function is used as a maximum counter in the following loop construction. Additionally, 

the same mw_mersenne_random subroutine is called as an index of the decoded_string_table. 

Therefore, the general idea seems being provide randomized strings.  

However, the part most interesting is the own mw_mersenne_random_subroutine. If you have any issues 

about the Mersenne Twister algorithm, so maybe the Wikipedia reference might be a start point in your 

learning: https://en.wikipedia.org/wiki/Mersenne_Twister. Anyway, the code is the following one: 

https://en.wikipedia.org/wiki/Mersenne_Twister
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[Figure 84] 

Going inside the mw_MT_twist_and_random subroutine, we have:  

 

[Figure 85] 

Nearly the code up to line 22 is related to generation of the next state and code from line 23 up to the end 

it’s related to providing a return of the random number.  

Looking around for other attractive subroutines, sub_10011865 subroutine might be an interesting place 

to take some the advantage of including a standard enumeration because there’re few Microsoft Crypto 

APIs such as: 

▪ CryptAcquireContextA: acquire a handle to a key container within a given CSP (cryptographic 

service provider). 

 

▪ CryptGenRandom: fill a buffer with cryptographically random bytes. 

 

▪ CryptReleaseContext: releases the handle of a cryptographic service provider (CSP) and a key 

container. 

As expected, there is always one or more numeric constants to be converted into symbolic constants and, 

in subroutine, we found that CryptAcquireContextA( ) has in its four parameter (dwFlags) a numeric 

constant (0xF0000000). If you read about this function on MSDN (https://docs.microsoft.com/en-

us/windows/win32/api/wincrypt/nf-wincrypt-cryptacquirecontexta) you’ll learn that all flags has a value 

with prefix ‘CRYPT_’ and it could be interesting to add all these dwFlags values at once to make your 

reversing quicker and simpler.  

https://docs.microsoft.com/en-us/windows/win32/api/wincrypt/nf-wincrypt-cryptacquirecontexta
https://docs.microsoft.com/en-us/windows/win32/api/wincrypt/nf-wincrypt-cryptacquirecontexta
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Thus, to do it you should go to Enumeration tab (SHIFT-F10) and press “INSERT” key. Once there, choose 

“Add standard enum by symbol name” and look for any of possible values for dwFlags. In this case, I 

picked up CRYPT_VERIFYCONTEXT (the first one in dwFlag possible values) and clicked “OK”; 

  

 

 

 

 

 

 

 

 

 

 

 

 

[Figure 86] 

If you check in Enumeration tab, so you’ll find our recent added enumeration and all CRYPT_* constants, 

as shown below: 

 

  

[Figure 87] 
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Now you can put the mouse on the constant, press ‘M’ hotkey and picked the offered crypto-constant: 

 

[Figure 88] 

By the way, if you remember, on Figure 80 / line 51, under mw_get_sysinfo (sub_1000D1C9), we have a 

wrapper to API NetGetJoinInformation( ) (named mw_NetGetJoinInformation). Moving inside this 

subroutine, there’re some conditional instructions related to the BufferType, which has the following 

possible values: 

 

[Figure 89] 

The procedure is always the same, but a little detail might change: 

a. Go to Enumeration tab (SHIFT-F10) 

b. press “INSERT” key.  

c. Once there, choose “Add standard enum by enum name”. 

d. Search for the enumeration _NETSETUP_JOIN_STATUS.  

e. As we’re focusing the analysis on APIs from MS SDK Windows 7, so pick it.  

f. Click “OK”; 

After adding a standard enumeration, go to the code and apply enumeration constants using ‘M’ hotkey: 
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[Figure 90] 

 

[Figure 91] 

Keeping our searching for interesting stuff, the sub_1000FB74 subroutine calls once again the decoder of 

the string table (mw_decode_string_table_2) and we used our previous IDA Python script again to mark 

up as comment all of strings over the code:   

▪ comment_string_offset(0x1001D0B0, 0x1001D050, "mw_w_decode_string_table_2") 
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Decrypting strings is always useful to understand the context of subroutines such sub_1000FABA, which 

handles and remove existing persistence (are they fake?) before start a process. In this case, strings tells 

about persistence on Registry (SOFTWARE\Microsoft\Windows\CurrentVersion\Run) and scheduled tasks 

(schtasks.exe /Delete /F /TN %u) as shown below: 

 

 

[Figure 92] 

[Figure 93] 
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Analyzing the CAPA Explorer’s output, it suggests that there’re two references to subroutines checking of 

HTTP status code. The second one is sub_1000E815 subroutine (renamed as mw_HTTP_stuff), which it’s 

huge and has lots of Wininet APIs as shown below: 

 

[Figure 94] 

This sub_1000E815 subroutine has a sequence of calls to well-known WinINet APIs such as:  

▪ InternetCrackUrlA 

▪ InternetOpenA 

▪ InternetSetOptionA 

▪ InternetConnectA 

▪ HttpOpenRequestA 

▪ InternetQueryOptionA 

▪ InternetSetOptionA 

▪ HttpSendRequestA 

▪ HttpQueryInfoA 

At time moment a critical question comes up: where IP addresses are? We haven’t seen any IP address 

over the code and, worse, all decrypted strings so far don’t have any IP address too. However, we just 

learned that the malware is communicating with C2 by using all these WinINet APIs, so at any point prior 

this subroutine should have references to IP addresses. Where are they? 

Using cross-references (‘X’ hotkey), you can “go up” in the sequence of subroutine calls and try to 

understand what’s the path to get to this WinINet APIs and, along the path, look around for interesting 

subroutines.  
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Therefore, using cross-references, we should jump to sub_1000EBE2 → sub_1000EB81 → sub_1000729B. 

At the middle of the path, we learn that sub_1000EB81 has an interesting Sleep( ) function managing 

intervals of calls for sub_1000EBE2 subroutine and restricting it in something between 2 and 6 seconds. 

In sub_1000729B subroutine we have a call for sub_1000719F that is before the sequence of calls to APIs 

mentioned in the previous page. Moving inside sub_1000729B, the code seems being interesting:  

 

[Figure 95] 

The function on line 14 is related to Mersenne Twister, which we’ve already explained previously, but 

subroutine call on line 15 we have a promising call to sub_10007118 (renamed as mw_w_SHA1). Go into 

this subroutine, we an interesting piece of code: 

 

[Figure 96] 
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The sub_1000F681 subroutine (named mw_SHA1) on line 16 is a SHA1 routine and its first lines provide 

necessary cryptographic constants to confirm it (check SHA1 pseudo code here: 

https://en.wikipedia.org/wiki/SHA-1):  

 

[Figure 97] 

Returning to mw_w_SHA1, there’s call for sub_1000F353 (renamed as mw_RC4_init), which is a slightly 

modified KSA (Key-scheduling algorithm) that the reader can check reference on 

https://en.wikipedia.org/wiki/RC4: 

 

[Figure 98] 

Returning to sub_1000719F subroutine (mw_SHA_RC4) on Figure 96, the call to sub_1000F3C5 on line 18 

accepts the key stream returned by mw_w_SHA1 subroutine, so it’s a RC4’s PRGA, as expected:  

https://en.wikipedia.org/wiki/SHA-1
https://en.wikipedia.org/wiki/RC4
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[Figure 99] 

We’ve found three relevant pieces of our puzzle:  

a. a call to a SHA function (sub_1000F681 – renamed as mw_SHA1), which is called from 

sub_10007118 (renamed as mw_w_SHA1) . 

 

b. a call to a RC4 KSA subroutine (sub_1000F353) in  sub_10007118. 

 

c. a call to the RC4 PRGA routine (sub_1000F3C5, which was renamed to mw_RC4_PRGA) in 

sub_1000179F (renamed as mw_SHA_RC4). 

We need to find which the code is being decrypting using RC4. From Figure 95, list all references to 

mw_RC4_PRGA subroutine (sub_1000F3C5): 

 

[Figure 100] 
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Pick up the third reference (sub_10008F17) and go to there: 

 

[Figure 101] 

Basically we found the same three critical subroutines, but in a different order. Listing cross references to 

subroutine on Figure 101 (mw_w_RC4 -- sub_10008F17), we only found a couple of subroutines. Picking 

the first one up (sub_100089C6 – named as mw_ww_RC4), we have many instructions, but three 

important lines of code:  

▪ (line 22) mw_SHA(arg_key_buffer_1, (char *)arg_key);  

▪ (line 33) mw_w_RC4(0x14u, (int)key, key + 20, resource_size - 20, *arg_key_stream); 

▪ (line 40) mw_w_RC4(arg_key_len, arg_key_1 + 1024, key, resource_size, *arg_key_stream); 

Of course, if you noticed the argument’s names I used, so you can guess where we’re going to. Once again, 

list all cross-references to sub_10008F17 and you’ll find only two subroutines, so choose the first one 

(sub_10008AC1).  

Apparently, we didn’t found anything, but it’s too early to give up. Listing the cross-references to 

sub_10008AC1 subroutine, there’ll be only two references again and choose the second one 

(sub_10002783).  

We’re inside of sub_10002783 subroutine (named mw_w_resource_crypto_0), which is really essential for 

our goals and there’s three interesting lines here: 

▪ The call for sub_1000A6CA subroutine (mw_get_resources) on line 13. 

 

▪ The call to sub_10001080 subroutine (mw_w_decode_string_table_0) on line 18. We’ve already 

decoded the entired encoded string table and we know this specific one all bring the following 

string: \System32\WindowsPowerShell\v1.0\powershell.exe. 

 

▪ The call for sub_10008AC1 (named mw_w_resource_crypto) on line 19, which is exactly the 

subroutine that we came from.  

The sub_10002783 subroutine (named mw_w_resource_crypto_0) is the following one:  



https://exploitreversing.com 

 

80 | P a g e  
 

 

[Figure 102] 

There’s an additional and short string to on line 12: 5812. Write it down. Going into sub_1000A6CA 

subroutine, the mystery finally ends:  

 

[Figure 103] 
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Finally! This subroutine finds and loads resources data from the binary’s .rsrc section.  Return to  

sub_10002783 subroutine (named mw_w_resource_crypto_0) and ask for cross-references to 

sub_1000A6CA subroutine (mw_get_resources) and pick up the first one (sub_1000173B – renamed to 

mw_resource_decryptor) and you’re going to see the following relevant lines:  

 

[Figure 104] 

The idea is exactly the same:  

▪ (line 58) provides a resource identification (3719).  

▪ (line 59) gets the resource data. 

▪ (line 63) the same “strange string”.  

▪ (line 64) decrypts the provided resource data.  

Thus, it’s feasible to understand the sequence of events from Figures 102 and 104 and conclude that:   

▪ The two provided resource IDs are: 3719 and  5812 (from page 80). 

▪ The resource data is fetched.  

▪ A key is provided: \System32\WindowsPowerShell\v1.0\powershell.exe 

▪ The decrypting function (mw_w_resource_crypto) is called.  

▪ Following the decrypting function, we return to sub_100089C6 (renamed as mw_ww_RC4) again 

and have the same lines:  

 

▪ (line 22) mw_SHA(arg_key_buffer_1, (char *)arg_key);  

▪ (line 33) mw_w_RC4(0x14u, (int)key, key + 20, resource_size - 20, *arg_key_stream);  

▪ (line 40) mw_w_RC4(arg_key_len, arg_key_1 + 1024, key, resource_size, *arg_key_stream); 

 

A minimum interpretation of these line of code is: 

▪ The key is provided to a SHA1 subroutine. 

▪ The result from SHA1 subroutine (key_stream) is provided to RC4 routine. In this case the SHA1 

function is working as a Key Derivation Function (KDF).  

▪ The RC4 subroutine returns both resource data (lines 33 and 40).  

Is there any indicator that the stored information in the resource section are IP addresses? From 

sub_1000173B subroutine (named  mw_resource_decryptor), which is the same of Figure 104, list all 

cross-references and pick up the first one (sub_100019DE subroutine) and go to there.  
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Readers are going to see the inet_ntoa( ) function that converts an IPv4 address into an ASCII string in 

dotted-decimal format. Thus, we can confirm our hypothesis and the information stored in the .rsrc 

section is actually a set of C2’s IPv4.  

Nonetheless, it isn’t all. If readers repeat the process of getting the cross-references of sub_1000173B 

subroutine  (named  mw_resource_decryptor) and picking up the second cross-reference (sub_1000336E 

subroutine), so they are going to find a very suggesting line of code: 

▪ mw_w_str_length_char(&v21[v26], v29, "%u.%u.%u.%u:%u", v30, v31, v33, v36, v39); 

As you can guess, IP addresses seem to be formatted as X.Y.Z.W:port, so we have to take it into account 

while extracting and decoding resource data.  

Using Resource Hacker tool (http://www.angusj.com/resourcehacker/) the reader is able to confirm that 

there’re two resource IDs (3719 and 5812) as we’ve learned from the code: 

 

[Figure 105] 

It’s great! Our next task is writing a code to extract and decrypt the .rsrc section information and on page 

81 we have a good hint about what we need to do. As I showed in the previous page,  the mw_w_RC4 

subroutine (sub_100089C6 ) is called twice to decrypt both resource’s IDs, but pay attention to line 33 

(page 81). It suggests that the real data starts at byte 20 onward.  Curiously, 20 bytes are the same length 

of any hash provided by SHA1. A script must: 

▪ Extract the resource data.  

▪ Apply SHA1 on the key, so generating a derived key. 

▪ Decrypt the extracted resource data using this key.  

▪ Formatting the output to IPV4 notation.  

http://www.angusj.com/resourcehacker/
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As most malware threats, C2 IP addresses are followed by their respective ports, so the format has the 

following pattern: [4 bytes for IP Address][2 bytes for Port]. 

The following Python 3 script has been written for educational purposes and there are many lines of the 

code that wouldn’t be necessary (few of them are commented), but they might help you: 
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[Figure 106] 
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I’ve chosen not writing my own RC4 implementation (and there’re several ones available on the Internet) 

because PyCryptodome (https://pycryptodome.readthedocs.io/en/latest/src/introduction.html) works 

well for this kind of task. Additionally, I’ve also used an existing Python IP Address library (ipaddress: 

https://docs.python.org/3/library/ipaddress.html) because it makes the code more readable.  The output 

from our scripts can be checked against the Triage’s output on page 7 (when it was truncated):  

 

https://pycryptodome.readthedocs.io/en/latest/src/introduction.html
https://docs.python.org/3/library/ipaddress.html
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[Figure 107] 

From the output, we learned that the botnet’s name  is “obama150” and the number might be a reference 

of existing 150 IP addresses in the C2 configuration list. Additionally, the campaign ID is 1640256791. 

Once again, this decrypt script can be improved a lot in several areas by removing fixed inputs such as 

filename, encrypting key and resource IDs , but I think that it’s enough to understand the general idea. 

  

 



https://exploitreversing.com 

 

87 | P a g e  
 

6. Further observations 

The sub_100084AF subroutine shows us an interesting sequence of subroutine and Windows APIs calls:  

 

[Figure 108] 

Few of APIs being called are: 

▪ CryptDecodeObjectEx: this function decodes a structure of the type indicated by the 

lpszStructType parameter. 

▪ CryptAcquireContext: this function acquires a handle to a particular key container within a 

particular cryptographic service provider (CSP). 

▪ CryptImportPublicKeyInfo: this function converts and imports the public key information into the 

provider and returns a handle of the public key. 

▪ CryptCreateHash: this function initiates the hashing of a stream of data. 

▪ CryptHashData: this function adds data to a specified hash object. 

▪ CryptVerifySignatureA: this function verifies the signature of a hash object 

Based on APIs being invoked, this piece of code seems to be handling a public key involved in a C2 

communication. Furthermore, soon at its beginning, there’s an interesting XOR operation that take us to 

two encoded data in different binary sections, which encrypted data is stored in the .data section and the 

key is stored in the .rdata section. To extract, decrypt and format the possible public key we are going to 

use a script very similar to used previously, but slightly changed:  
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[Figure 109] 
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[Figure 110] 

Another very interesting subroutine is sub_1000D9B1 because there’re few interesting WMI strings such 

as ‘SELECT * FROM Win32_OperatingSystem’ and also ‘ROOT\CIMv2’.  Where’s the code referring WMI?  
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[Figure 111] 

Analyzing the sub_1000D6D0 subroutine, we have:  

 

[Figure 112] 

The class ID and interface ID values are stored in the .rdata section as shown below: 
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[Figure 113] 

Easily the reader is able to understand that class ID and interface ID are the following GUIDs: 

▪ rclsid: 4590F811-1D3A-11D0-891F-00AA004B2E24 

▪ riid: DC12A687-737F-11CF-884D-00AA004B2E24 

Looking for the interface ID (riid) on the Internet, the reader will discover that it refers to the 

IWbemLocator interface. Therefore, you change the type (‘Y’ hotkey) of ppv on line 8 and 12 from 

‘LPVOID’ to ‘IWbemLocator*’ and set ptr_buffer’s type to ‘IWbemServices *’ (check the allocation on line 

16), you’ll get a better pseudo code than the Figure 112:   

 

 [Figure 114] 
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As you probably already know, IWbemLocator interface offers Windows Management through 

IWbemServices, which is returned by the ConnectServer( ) method. In other words, 

IWbemLocator::ConnectServer creates a connection to a WMI namespace, so that’s the reason for we 

have seen a WMI query previously. Furthermore, the strings “ROOT\CIMv2” is passed within the  

strNetworkResource parameter to ConnectServer function, and it makes sense because this parameter 

must contain the object path of the WMI namespace.  

Returning to sub_1000DCE9 routine (renamed as mw_w_COM_IWbemLocator), we should change the 

result’s type on line 49 to IWbemServices * (same from ptr_buffer on Figure 114). Afterwards, change the 

type of v7 variable to IWbemServices ** on line 80 that ExecQuery( ) will come up. Remember that 

IWbemServices::ExecQuery method executes a query to retrieve object and whether the reader observe 

lines 63, 64 and 76, that’s exactly what’s happening (Figure 115): 

 

[Figure 115] 

In addition, the return of ExecQuery is its fifth argument that has a  IEnumWbemClassObject ** type. 

Thus, you need to set it to ‘IEnumWbemClassObject *’ (a reference already exists) and do the same for 

variable v9 (line 84).  

Soon the reader do it, the IEnumWbemClassObject::Next method also will appear in the code, which has 

the goal of getting one or more objects starting at the current position in the enumeration. Likewise, its 

third argument is type IWbemClassObject ** , but as there’s already an existing reference, so change its 

type to ‘IWbemClassObject *’.  

Likely the GetNames method, which retrieves the same of the properties in the object, will appear on line 

99. Remember that the GetNames method makes possible each property to be accessed by using  

IWbemClassObject::Get method. The Figure 116 shows the result of this manipulation:  
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[Figure 116] 

I’m going to return to COM (Component Object Model) topic in next articles, so even you didn’t 

understand details of this subroutine here, we have a better opportunity to talk about it in a near future.  

Changing the focus to another piece of code, Qakbot’s authors seems having used the same scheme (key 

→ SHA1 → derived key → RC4) to encrypt/decrypt Registry entries within sub_1000A23A subroutine, 

which is called several times (check its cross-references): 

 

 

 [Figure 117] 

Observe the sub_10004C5A subroutine shown below: 



https://exploitreversing.com 

 

94 | P a g e  
 

 

[Figure 118] 

We can realize that the initial key that’s derived by the SHA1 hash function comes from a composition of 

the computer name, account and volume information. Furthermore, it seems that malware is concerned in 

manipulating the key “SOFTWARE\Microsoft\Microsoft Antimalware\Exclusions\Paths” to, eventually, 

include itself as an authorized anti-malware tool and stay out the radar.  

The sub_10002E98 subroutine (renamed as mw_GetKeyBoardLayoutList) checks for input locale 

identifiers to check whether the installed keyboard is Russian, Belarusian, Tajik, Ukrainian, and so on: 

 

 

[Figure 119] 

Another curious point are the references done by getting a handle for two Avast protection’s DLLs 

(aswhooka.dll and aswhookx.dll) inside the sub_10004FB9: 
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[Figure 120] 

At the same subroutine, it establishes persistence by using the string ‘ 

“C:\Windows\system32\schtasks.exe” /Create /RU “NT AUTHORITY\SYSTEM /tn <random name> /tr 

“regsvr32.exe -s …” ’ and soon afterwards it creates the respective process (sub_1000AAC1), as shown in 

the Figure 121 and Figure 122 respectively:  

 

[Figure 121] 

 

[Figure 122] 
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7. Conclusion 

There’re many other quite fascinating lines of codes to be analyzed (there’re 510 functions!) and It would 

be possible to extend this article in dozens of further pages. For example, I could have analyzed C2 

communication, other code injection techniques and lot of other aspects of the code, but I think it’s 

enough for now.  

My goal, as I had already mentioned in the first article, is offering a kind of review for reverse engineers to 

learn something new and have a kind of guideline to follow and search when it’s necessary. Of course, next 

articles might not be so extensive as this one, but I will try to cover different aspects and topics as possible.  

This article will have mistakes and error, but it isn’t big deal. Soon I find them, I’ll release a new revision of 

this document.  
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Just in case you want to keep in touch: 

▪ Twitter: @ale_sp_brazil 

▪ LinkedIn: https://www.linkedin.com/in/aleborges 

▪ Blog: https://exploitreversing.com 

 

Keep reversing and I see you at next time! 
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